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Introduction 

CAPRI Definition 

The Compensation and Pension Record Interchange (CAPRI) project is an information 

technology initiative to improve service to disabled veterans by promoting efficient 

communications between the Veterans Health Administration (VHA) and Veterans Benefits 

Administration (VBA). Online access to medical data enhances the timeliness of the benefits 

determination. Previous attempts to automate this process were hindered by the "roll and scroll" 

nature of the VHA computer interface of the Automated Medical Information Exchange (AMIE) 

II. The CAPRI software acts as a bridge between the VBA and VHA information systems. It 

offers VBA Rating Veteran Service Representatives and Decision Review Officers help in 

building the rating decision documentation through online access to medical data. It offers VHA 

Compensation and Pension (C&P) staff an easy, standardized way of recording C&P 

Examination reports. 

Using CAPRI, VBA employees have a standardized, user-friendly method to rapidly access 

veterans' electronic medical records throughout the Veterans Administration (VA). CAPRI 

delivers leading edge "point and click" technology to the users' desktops. In addition, the 

learning curve for CAPRI is significantly less than for character-based systems. CAPRI builds 

upon existing VHA information security approaches. In addition to using established 

mechanisms to ensure only authorized access to medical data, CAPRI adds a level of security by 

allowing VBA users to read but not alter electronic medical record information. CAPRI also 

provides innovative improvements for medical centers by integrating highly detailed 

Compensation and Pension Rating examination results into the veterans' medical records. 

Previously, these reports were not retained online in medical center computer systems but were 

archived onto paper. This procedure precluded the sharing of clinically useful data. 

Initially developed specifically for VBA, the utility of CAPRI has been expanded to other user 

groups that include VHA, Office of the Medical Inspector, Office of Information (OI), Research, 

and Veteran Service Officers. Recently, most of the newest features of CAPRI are specifically 

targeted at adding features to be used by VHA C&P providers and staff. 
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CAPRI Application Features
 
User friendliness 

Point and click environment 

No commands or prompts to memorize 

Facilitates copy and paste functionality 

Consistent appearance and functionality from site to site 

Demographics 

Load new patients into the Veterans Information Systems Technology Architecture (VistA) 

system 

View patient demographics 

Report patient address changes to VHA 

View patient temporary address 

C&P Examination Functionality 

Add new C&P exam request 

Edit unreleased C&P exam request 

Add exams to C&P exam requests 

Cancel C&P exam requests 

Create an insufficient exam request 

Track individual and cumulative pending exams 

Request Veterans Affairs Form (VAF) 7131 information 

Create VA Regional Office reports 

Create AMIS 290 report 

Create insufficient exam report 

Send Automatic Mailman bulletins to AMIE mail groups 

Patient Records Navigation 

View health summaries 

View appointment lists 

View progress notes 

View discharge summaries 

View consult requests and results 

View cumulative vitals 

View active medications 

View lab reports 

View imaging 

View procedures 

View FHIE/DoD data, if available 
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Reports 

All existing AMIE reports for VBA are available 

Custom C&P template tracking reports for VHA are available 

Other C&P activity reports not available in AMIE 

C&P Exam Entry 

All standard AMIE worksheets are available in template form 

Automatic sending of completed exam requests 

Ability to save template work in progress and finish later 

Ability for site to review exams before releasing it to VHA 

Multiple templates can be merged into a single exam 

Additional Information 

Additional information and downloads are available on the VA Intranet. 

CAPRI Documentation: 

http://www.va.gov/vdl/application.asp?appid=133 

CPEP Website: 

http://vaww.cpep.med.va.gov/DEFAULT.HTM 

VHA CAPRI Training, Videos, and Documentation: 

http://vaww.cpep.med.va.gov/capri/default.htm 

VBA Compensation and Pension Service CAPRI page: 

http://vbaw.vba.va.gov/bl/21/Systems/capamie.htm 

E-Mail Address 

User support questions should be addressed to local IT support staff (Information Resources 

Management (IRM)) or the national VistA Helpdesk. 

If the user has a need to contact the CAPRI development team directly, they can be reached at 

the Outlook mail group: VHA OI SDD CAPRI. 
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Installation 

Note: It is important that all users at your site remain on the same version. 

For Veterans Benefits Administration (VBA), the new version runs when the user starts the 

application from Start/Vbapps/Capri/Capri. The user can make new Windows desktop 

shortcuts after starting the new version. 

For the Veterans Health Administration (VHA), the IRM department will install the CAPRI 

desktop icon. Please check with them on the specifics of starting CAPRI. Normally, the user 

should find the CAPRI shortcut in the same place the user would find CPRS. 

LOCAL VISTA CONNECTION: The CAPRI shortcut can be set to connect to a specific 

VistA system. CAPRI will accept the command line parameters s=servername and 

p=portname, just like CPRS. 

fig. 1-1 

CAPRI REMOTE: CAPRI Remote users access CAPRI through the Claims system, which 

runs on the VHA Forum hardware. The server for those users should be set to forum.va.gov, 

port 9400 (fig. 1-1).  See CAPRI Remote Functionality section in this user manual for more 

details. 
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Add/Remove Medical Centers
 
Local IRM staff can set up a list of available VHA servers that the user may need to connect 

to on a regular basis. Please contact IRM if the user needs to have a facility added or 

removed. IRM staff can add multiple VistA connection configurations to CAPRI using the 

standard serverlist.exe utility provided with the RPC Broker. IRM should refer to the RPC 

Broker documentation for specifics on how to use serverlist.exe. 

If using command line parameters to direct the CAPRI shortcut to a specific server and port, 

the settings from serverlist.exe is ignored. The example in Step 2 below refers to a system 

that has been set up with serverlist.exe and has no server or port information in its shortcut. 

Logging On 

Non-CAPRI-Remote Users 

Step 1 – Double-click the CAPRI icon. 

Step 2 – OPTIONAL - If the workstation has been configured with serverlist.exe by IRM, and if 

there is no server and port information in the CAPRI shortcut, a window will appear asking the 

user to select an initial server and port (fig. 1-2). Click the down arrow shown in the upper right 

corner to show all the VHA sites the user can access. A scroll bar will appear if the list is too 

long to be displayed. If the user only have access to one VHA facility, the user will immediately 

see the VistA sign on screen in step five (fig. 1-4). 

Step 3 – OPTIONAL – The user scrolls to the name of the desired VHA facility, if it is not 

already visible, and clicks it to select it (fig. 1-2). 

fig. 1-2
 

Step 4 – OPTIONAL – The user clicks OK (fig. 1-3).
 

fig. 1-3 
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Step 5 – The user enters a VistA Access Code, presses the Tab key, and then enters the Verify 

Code. The user then presses Enter or clicks OK (fig. 1-4). (Contact your local IRM staff if the 

user is new and needs an access code). This takes the user to the Patient Selector Screen 

described in the CAPRI – Use of the Software section.  

fig. 1-4 

RO CAPRI-Remote Users 
Most VBA users are CAPRI-Remote users.  CAPRI-Remote users need only one Access Code 

and Verify Code to connect to authorized VAMC sites.  

Step 1 – From the Start/VBAPPS/CAPRI Remote/CAPRI Remote menu, click the CAPRI icon.  

Step 2 - Enter your VISTA Access Code, press the Tab key, and then enter your Verify Code. 

Press Enter or click OK (fig. 1-4a).  (Contact your local IRM staff if the user are a new user and 

need an access code).  

NOTE:  If this is your first time logging into a VISTA application, only enter your Access Code.  

CAPRI will then prompt the user to create a Verify Code.  Most users should have a valid 

Access and Verify Code combination by the time they use CAPRI. 
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Fig. 1-4a 

OPTIONAL - To change the Verify Code, the user selects the Change Verify Code checkbox 

on the sign-on dialog.  The user will then be prompted to create a new Verify Code as shown in 

the steps in fig. 1-4b 

Fig. 1-4b 
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After clicking OK, the user is prompted to enter and confirm a new Verify Code.  

Fig 1-4c 

Step 3 – The CAPRI Remote site selection screen (fig. 1-4d) displays the user’s authorized VHA 

facilities.  If shown, the vertical scrollbar is used to scroll through all authorized sites.  The user 

selects a site with the mouse, and then either double-clicks the site or clicks OK to access that 

site.  Fig. 1-4d shows Bay Pines as the selected VHA facility.  

Fig. 1-4d 

After CAPRI loads the VHA facility, the user is prompted with the Patient Selector screen (fig. 

1-4e). Instructions for use of the Patient Selector screen are found in the CAPRI – Use of the 

Software section of this document.  
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Fig. 1-4e 

Terminal Server Users 
Step 1 - From the Hines terminal server application, the user double-clicks the CAPRI icon.  

Step 2 –Steps 2-3, listed above, are followed by RO CAPRI-Remote Users. 

CAPRI News 
Before logging on to CAPRI, News alerts are displayed if new items exist. The user can click the 

new News item to view the contents.  

The user clicks Clear All to remove all News items.
 
The user can then click Close to continue working with CAPRI.
 

fig. 1-5 

November 2008 CAPRI GUI DVBA*2.7*123 User Manual 9 



        

 

 

 

 
 

 

 

    

  

  

 

      

    

 

 

  

   

        

   

 

    

  

     

    

   

 

   

Logon Alerts 

When users of the CAPRI C&P Template functionality log in to CAPRI, the CAPRI Template 

Alerts are displayed. 

fig. 1-6 

CAPRI automatically checks pending CPWM Templates statuses. Pending templates in the 

user’s queue are displayed on the alert screen. The C&P Alerts Screen displays alerts according 

to template status. Alerts for template statuses of: draft, awaiting signature, sent back from 

reviewer, requiring review, CPRS documents to cosign, and cosigned documents ready to 

transfer to AMIE are displayed. 

The user clicks the Resolve This Alert button to be taken to the section of CAPRI where the 

alert can be resolved. For example, if the user has unsigned templates, then he or she is taken to 

the Unsigned Templates window. 

The user clicks Continue to bypass the alerts and go to the Patient Selector Screen. 

CAPRI – Use of the Software 

Patient Selector Screen or Patient Entry / Selection 

Security Note: The Compensation and Pension Record Interchange (CAPRI) application does 

not allow the user to view your own personal patient records. If the user attempt to do so, CAPRI 

prevents access and alerts the Security Administrator at the Veterans Health Administration 

(VHA) facility, who will take established security violation actions. In addition, when selecting a 

patient who is a VA employee, CAPRI allows the user to do so only after the user agree to 

Privacy Act Terms via a dialog box. An alert is sent to the Security Administrator who will 

inquire about your business reasons for accessing those records. 

Selecting a Patient / Veteran 

The Patient Selector Screen allows the user to search the Veterans Information Systems 

Technology Architecture (VistA) database for patients who have records. Patients can be located 
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using a Social Security number, the last name initial plus the last four digits of Social Security 

number, or by typing in the veteran’s last name and first name. Current users of the Automated 

Medical Information Exchange (AMIE) II will recognize that these are the same search methods 

for that application as well. 

Note: If the user is looking for existing VHA medical records and the patient selection search 

yields no results, then there are no existing VHA medical records for that patient at the facility 

that was accessed. Verify that the user typed in the Social Security number correctly and that the 

user is logged into the correct VHA facility. 

To avoid displaying sensitive information regarding our patients and staff, the examples in this 

manual contain pseudonyms instead of real names. Patients and staff are referred to as 

CPRIPATIENT, ONE, PROVIDER, ONE, or USER, ONE. Likewise, real Social Security 

numbers (SSNs), real addresses, and other personal identifiers are not used. 

Step 1 – To begin the search, the user clicks File/Select Patient and enters the veteran’s 
information (fig. 2-1). For example, if the user wants to view the records of CPRIPATIENT, 

TWO (SSN: 666080315), the following would be the valid search methods: 

Social Security number (preferred method): enter 666080315 and click Select.
 
Last name initial and last four of SSN: enter C0315 and click Select.
 
Name: enter CPRIPATIENT, TWO and click Select. Note: there is NO space between the 

comma and the last name. 

fig. 2-1 

Step 2 – CAPRI displays a list of possible matches (fig. 2-1). The user clicks once on the 

patient’s name to display more information to help verify that the user has selected the correct 

veteran. This additional information includes the patient’s full name, Social Security number, 

Claim number, gender, age, and date of birth. If there is only one match, this information is 

displayed automatically. After choosing the correct veteran, the user clicks the Select button. 
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Step 3 – After the user have clicked the Select button, CAPRI builds all of the background 

information on that veteran and automatically opens to the C&P Exam Tab. From this starting 

point, the user be able to request a C&P exam for the selected veteran or click on any of the other 

tabs to navigate existing patient records. 

Step 4 – To select another patient, click File/Select Patient and return to Step 1. 

*Note: CAPRI notifies the user if the patient is deceased and allows the user to Continue or 

Cancel. When the user searches using the Patient Selector screen, a message will indicate if the 

patient is deceased (fig. 2-1a). 

Fig. 2-1a 

If the user click Select, the following dialog box appears (fig. 2-1b) with the patient’s date and 

time of death. 

Fig. 2-1b
 

Click Yes to continue or No to cancel (fig. 4-3).
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Entering a New Patient / Veteran 
Note: The user should not enter new patients unless authorized to do so. A special security key, 

DVBA CAPRI SIMPLE PT ENTRY, has been created to allow Suicide Hotline users the ability 

to enter a basic patient record for the purpose of quickly initiating care. Additionally, VBA users 

should only establish a new patient within the VISTA system if it is necessary to request a C&P 

examination for a veteran who is not a current patient within the medical facility’s database.  If 

the patient NAME and SSN search using CAPRI’s Patient Selector function yields no results, i.e., 
―Match not found,‖ then the user must establish the veteran as a new patient. 

Step 1 – Click the Enter New Pt. button at the bottom of the Patient Selector Screen (fig. 2-2). 

fig. 2-2 

Steps 2 – Enter the veteran’s Social Security number in the space provided, and then click 

Verify SSN is Not in Use (fig. 2-3). 

fig. 2-3 
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Step 3 – If the Social Security number is not associated with an established patient record, 

CAPRI opens the Enter New Patient template (fig. 2-4). 

fig. 2-4 

When the user selects Click to Continue, a query is run to find any existing patient with the 

following information similar to the new patient. 

First 2 letters of the First and Last name are the same 

Same last 4 of the social 

Same Year and Month of the Birth date 

Same Year and Day of the Birth date 

The query results are displayed so that the user may manually verify that the new patient does 

not already exist. The name, gender, date of birth, and Social Security number of the potential 

matches are displayed, as shown (fig. 2-5). 

fig. 2-5
 

The user has the option to Cancel New Patient Entry or Continue With Patient Entry.
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Step 4 - If Click to Continue is selected, the remainder of the required fields are displayed (fig. 

2-6) and a stub record is created within the VistA system. Clicking Cancel at this point leaves an 

incomplete record. 

fig. 2-6 

If the incorrect Service Entry or Separation Dates is entered, click the Clear button to remove 

the incorrect data from the field, and then enter the correct date. There are several fields on the 

template with drop-down arrows, which show the only valid choices for each particular field. 

Click the selection that applies. For example, the drop down arrow for the field, Patient Type, 

shows the following valid selections (fig. 2-7): 

fig. 2-7 
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The selection list for the Claim Folder Location requires the user to select the appropriate entry 

and then click OK (fig. 2-8). 

fig. 2-8 

The selection list for the State and County requires the user to select the appropriate entry from 

the list and then click Accept Selection (fig. 2-9). 

fig. 2-9
 

Step 5 - Click Add Patient to establish the new patient or click Cancel if the user no longer 

wish to add the patient (fig. 2-6).
 

Notes on adding new patients:
 
CAPRI automatically uses all capital letters in all fields; the user do not have to capitalize 

individual letters 

Do not use punctuation marks, special characters, or spaces in any of the name fields 

Do not use punctuation marks in any of the address fields 

Do not use parentheses for the area code of a phone number; use a hyphen between the area 

code and number, e.g. 555-555-5555 

Step 6 - After the user have completed the Enter New Patient template and have clicked the Add 

Patient button (fig. 2-6), CAPRI builds a new patient record for the veteran and automatically 

opens that record in the C&P Exams tab. 

Step 7 - The new patient is established in VistA and the user are now ready to request a C&P 

Examination for him or her. 
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Other Facilities Visited by a Veteran 
A CAPRI-Remote user can switch to other VA Medical Center (VAMC) sites and automatically 

view the patient’s record even if the user normally does not have access to those VAMC sites.  

The Other Facilities Visited by Vet tab allows a user to identify all VAMCs where a patient may 

have visited, and also identifies the last time the patient may have received treatment at that 

VAMC site.  

Fig 2-9a shows where to find the Other Facilities Visited tab.  From the Patient Selector screen, 

the Other Facilities Visited by Vet tab is grayed out and disabled when there is no electronic 

record that the patient has visited another VAMC site.  

Fig. 2-9a 

When viewing a veteran’s patient records, the Other Facilities Visited tab is located in the 

upper left hand corner (fig. 2-9b).  

Fig. 2-9b 
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After selecting the Other Facilities Visited by Vet tab (either from the Patient Selector screen 

or while viewing a named veteran’s records), the user is presented with a list of VAMCs where 
the veteran may have visited (fig. 2-9c).  Choose a VAMC, and then select the Switch to This 

Facility tab. 

Fig. 2-9c 

After switching to the other site, the user has full ability to navigate the named veteran’s patient 

records using CAPRI.  

Unless the user has direct access to the switched site, the user  is not able to use the File menu to 

search for other patient records at the switched site. Instead, the user receives the message in fig. 

2-9d 

Fig. 2-9d 

NOTE:  The Remote Data View tab under the Health Summaries tab is now grayed out and 

permanently disabled.  The Other Facilities Visited tab replaces Remote Data View functionality.  

CAPRI GUI DVBA*2.7*123 User Manual November 2008 18 



 

        

 
 

  

  

  

 

 
 

 

 
 

 

     

  

 

 
 

 

Enterprise Search Function 
The Enterprise Search function can be used to search all VAMC VistA systems to see where a 

patient has presented for care.  This function allows the user to enter a combination of patient 

name and SSNs to search through selected VAMC systems to see if a patient match exists.  This 

functionality is available from CAPRI’s Tools menu as well as on the Patient Selector Screen. 

fig. 2-10 

Fig. 2-10a 

Step 1 – From the Search For field (fig. 2-10a), click the ―?” button, circled above, to receive 

instructions for entering search parameters in fig. 2-10b. 

Fig. 2-10b 
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Step 2 – Single site or multiple site searches can be done, as described below.  

Searching one site: After entering patient search data, the user selects one site with a mouse-

click, and then clicks Run Selected. 

Fig. 2-10c 

Searching all sites in list: After entering patient search data, the user clicks the Select All button, 

and then clicks Run Selected. (Fig. 2-10d) 

Fig. 2-10d 

Searching multiple sites: After entering patient search data, the user selects one site with the 

first mouse-click, then holds the control key on the keyboard while clicking the names other sites. 

After choosing all of the desired sites, the user clicks Run Selected. (Fig. 2-10e) 
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Fig. 2-10e 

Searching a group of sites in the list: After entering patient search data, the user selects one 

site, holds the shift key on the keyboard, and clicks the last site in the grouping search. Then, the 

user clicks Run Selected. (Fig. 2-10f) 

Fig. 2-10f 

Step 3 – Potential Matches received after running a selected search parameter are shown in fig. 

2-10g. The user can move the vertical scroll bar (circled) to see the complete list.  
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Fig. 2-10g
 

If CAPRI is unable to connect to a selected site, that information is also reported.  (Fig. 2-10h)
 

Fig. 2-10h 

C&P Exam Requests 

The C&P Exam tab (fig. 2-11) includes functions such as: 

Requesting C&P examinations 

Viewing/editing requests 

Canceling requests 

Adding an exam to a pending request 

Creating status inquiry reports 

Viewing completed requests 

Tracking the progress of the request for claims management purposes 

Requesting an ―Insufficient Exam‖ 
Printing results for individual patients 
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Pending requests are shown with a date only in the left column and completed requests have a 

completion date in the right column. When the user first accesses this screen, none of the 

examinations are selected, and only the Add a New Request button is enabled. After the user 

selects an examination, the Re-Print Final C&P Results, the Status Inquiry, and the 

View/Edit Selected Request buttons are enabled. 

C&P Exams screen: 

fig. 2-11 

View/Edit Selected Request 
Step 1 – The user logs into CAPRI, looks up the veteran using the patient selector, and moves to 

the C&P Exams tab (fig. 2-11).  If there are no examination requests, the window is blank.  If the 

veteran already has examination requests on file, the window will show the dates requested. 

Step 2 – The user selects the examination request date, and clicks the View/Edit Selected 

Request button (fig. 2-11). 

Step 3 - The View C&P screen opens, showing all of the entries from the original request, as 

well as the examination status (fig.2-11a).  The user can scroll down to see additional 

information from the original request.  The exam in this request cannot be edited since it was 

already completed, but the original request may be viewed. 
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Fig. 2-11a 

Step 4 - If the user wants to edit a request that is still pending and has not yet been scheduled, it 

can be done on this screen (fig. 2-11a) (if not, skip to step 8). The user can edit Claim Folder 

Required, Priority of Exam(s), Routing Location, Comments, and Other Disabilities by typing 

directly into those fields.  To add another examination, the user clicks the ―Add Exam to 

Request‖ button (fig. 2-11b). 

Fig. 2-11b 

Step 5 - If the ―Add Exam to Request‖ button is clicked, the exam listing field opens allowing 

the user to make a selection (fig. 2-11c).  The user can scroll down the list, or use the ―Find by 
Body System‖ button.  
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Scroll list view: 

Fig. 2-11c 

Step 6 - In the scroll list view (fig. 2-11c), the user clicks the checkbox next to the desired 

examination.  In the ―Find by Body System‖ view (fig. 2-11d), the user scrolls down the body 

systems until the correct one is found, then single-clicks the + in front of the body system (or 

double-click on the body system to open a list of all pertinent examinations. The user double-

clicks the desired examination to add it.  The view will revert to the scroll list view, and that 

examination is checked. 

―Find by Body System‖ view 

Fig. 2-11d 

Step 7 - Click ―Add Selected Exams‖ or ―Cancel Add Exams‖ as appropriate (fig. 2-11c). 

Step 8 – The user can click ―Close Window‖ to close this screen, or click ―Add An Insufficient 

Exam Request‖ if this examination was completed but is insufficient (fig. 2-11a).  See Add A 

New Request for additional information. 
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Cancel an Exam Request 

Step 1 – After logging into CAPRI, the user looks up the veteran using the patient selector, and 

moves to the C&P Exams tab (fig. 2-11).  If there are no examination requests, the window is 

blank. If the veteran already has examination requests on file, the window will show the dates 

requested. 

Step 2 – The user selects the examination request date, and clicks the ―View/Edit Selected 

Request‖ button (fig. 2-11). 

Step 3 - The View C&P Exam screen opens, showing all of the entries from the original request 

and the examination status (fig. 2-11e).  The user can scroll down to see additional information 

from the original request.  

Fig. 2-11e 
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Step 4 - To Cancel ALL Exams, the user scrolls down to the Exams Requested section and clicks 

that button (fig. 2-11f).  To cancel selected exams, skip to step 6. 

Fig. 2-11f 

Step 5 - CAPRI opens a dialog box for the user to confirm the selection (fig. 2-11g).  The user 

clicks ―Yes‖ to cancel the exams or ―No if the user still wants the exams to be completed. 

Fig. 2-11g 

Step 6 - To cancel selected exams, the user scrolls down to the Exams Requested section (fig. 2-

11i), clicks the exam to be canceled, and clicks the ―View Selected Exam‖ button. 

Fig. 2-11i 

Step 7 - The C&P Exam Details screen opens (fig. 2-11j).  The user can review the exam request 

to ensure that the correct exam is selected before clicking the ―Cancel this Exam‖ button. 
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Fig. 2-11j 

Step 8 - A box opens for the user to select the cancellation reason from the supplied list (fig. 2-

11k).  The OK button is not available until a reason is selected.  After selecting the most 

appropriate reason, the user clicks OK to cancel the selected exam or Abort and DO NOT 

CANCEL! to keep the exam. 

Fig. 2-11k 

Step 9 - If OK was selected to cancel the exam request, CAPRI displays a confirmation box (fig. 

2-11l).  The user can click Yes to cancel the exam or No to keep the exam. 
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Fig. 2-11l 

Step 10 - If Yes is selected, CAPRI opens another box for the user to enter comments that are 

sent with the cancellation message to VHA (fig. 2-11m).  After entering comments, the user 

clicks Done. 

Fig. 2-11m
 

Step 11 - The C&P Exams tab will now show the canceled exam (fig. 2-11n).
 

Fig. 2-11n 
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Add a New Request 

Step 1 – The user logs into CAPRI, looks up the veteran using the patient selector, and moves to 

the C&P Exams tab (fig. 2-11).  If there are no examination requests, the window is blank.  If the 

veteran already has examination requests on file, the window will show the dates requested. 

Step 2 - If previous examination requests exist, the user views those requests as described in 

View/Edit Selected Request to ensure that the user is not about to enter a duplicate request for an 

examination. 

Step 3 – After ensuring that the exam about to be requested is not already pending, the user 

clicks the Add a New Request button (fig. 2-11). 

Step 4 – CAPRI prompts the user to check the latest address of record in the VISTA system (fig. 

2-11o). If the veteran has a new address, the user clicks the ―Edit Address Now‖ button.  If the 

user is not sure if the new address is more current than the one shown by CAPRI, then the 

Permanent Address is not updated and instead this fact is noted and the new address is included 

in the general comments area of the exam request.  

If the Permanent Address shown by CAPRI is current, the user clicks OK.  If the user enters a 

change to the Permanent Address information, it will not update the address information 

directly in the VHA database, as in previous CAPRI versions.  Instead, this information is 

appended as text to the examination request, where it can be further edited if necessary. 

NOTE: VBA users cannot edit the Temporary Address information in fig. 2-11o.  

Fig. 2-11o 
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Step 5 – If the user selects the Edit Address Now button, edits can be entered and the user has 

the option of either saving or not saving the address changes to the C&P Exam request (fig. 2-

11p).  After the user selects OK from fig. 2-11p, or either the Don’t Save button or the Save 

Changes With C&P Request button from fig. 2-11p, an Add a New C&P Exam dialog box 

opens (fig. 2-11q). 

As shown in fig. 2-11q, certain VHA facilities have added new examination list functionality.  

For these facilities only, supported exams are shown in black, and exams shown in red may not 

be supported by the selected facility.  Routing Location Information and Information about 

this Exam List status messages have been added to the template.  Pop-up messages may appear 

during exam selection, depending on how the exam list has been set up by the C&P clinic or 

MAS.  The user completes the various request fields by using the Tab key or the mouse to move 

from field to field.  Several fields have drop down arrows which show the valid selections for 

that particular field. All of the fields except for Other Disabilities require an entry.  The Other 

Disability field is not used by all VBA Regional Offices.  Note:  if the user did not use this field 

with the AMIE software, then it will not be used with CAPRI.  

The user can select as many Exams to Complete as required by the particulars of the veteran’s 

claim.  The user must remember to justify the request by entering comments that explain the 

choice of exams.  The Exams to Complete section works the same way as described in steps 

five and six in the View/Edit Selected Request section. 

Fig. 2-11p 
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Add New C&P Exam screen: 

Fig. 2-11q 
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Step 6 – The user enters comments into the Comments field with the information to provide to 

the C&P physician concerning the veteran’s disabilities along with the reason for the user’s 
selection of examinations (fig. 2-11q).  The Comments area is Windows-compatible and supports 

copy and paste commands.  The user carries out copy and paste commands by either clicking 

Edit, located in the gray bar at the top of the screen, or by right-clicking the mouse in the 

comments area.  The copy and paste features is of benefit for lengthy BVA Remand instructions 

for C&P examinations and also for those RVSRs and DROs that keep a card file or other 

electronic system of exam paragraphs with standardized sentences that are used on a frequent 

basis.  Additionally, the C&P medical opinion request template can be pasted into the Comments 

section.  

The Exam Request Template button was added to automate some of these paragraphs.  It opens 

another screen (fig. 2-11r), which is an optional feature, that allows the user to make selections 

that use standard language and will appear on the examination request.  It has tabs for Info, 

SC/Increased Eval, Pension, Medical Opinion, and Contact Info.  Use of these templates is 

optional. 

The Info tab has general information for the examiner (fig. 2-11r). 

Fig. 2-11r 
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The SC/Increased Eval tab allows the user to specify a Power of Attorney, indicate the 

conditions that the veteran is claiming service connection for, and indicate what service 

connected conditions the veteran is claiming an increased evaluation for (clicking the Add New 

button opens the bottom Medical Condition fields) (fig. 2-11s).  Note: When a medical opinion is 

required for a claim of service connection, DO NOT use the Veteran claims service connection 

for selection; instead refer to the VBA M21-1, MR for guidance as to what is required.  

Fig. 2-11s 
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The Pension tab allows the user to indicate what medical conditions must be evaluated for a 

determination of pension entitlement (fig. 2-11t). 

Fig. 2-11t 

The Medical Opinion tab allows the user to indicate that an opinion is needed (fig. 2-11w).  The 

user can copy/paste into this box by pointing to it and clicking the right mouse button. 

Fig. 2-11w 
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The Contact Info tab gives the user a pre-formatted area to indicate a station contact if the 

examiner has any questions about the request (fig. 2-11x).  CAPRI remembers this information 

and automatically populates these fields the next time this template is used. 

Fig. 2-11x 

The user clicks Done when finished to enter all of the applicable templates. 

Step 7 – The user reviews the request to ensure all the correct information has been entered.  

After making sure that no additional information is required, the user clicks the Send Exam
 
Request button at the lower left corner of the screen. The user may also click Cancel Request, if 

appropriate.  Answer the confirmation dialog box that appears.
 

Step 8 - The request is transmitted to the VHA facility and CAPRI shows that the request is 

pending.
 

Step 9 – To place proof of the exam request in the claim file for recordkeeping purposes, the user
 
selects the Status Inquiry option and prints the Inquiry screen.
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Insufficient Exam Request 
This option is used if a completed examination is not sufficient, and the RO has followed local 

procedures to attempt to make the examination sufficient for rating purposes. 

Step 1 - Log into CAPRI, look up the veteran using the patient selector, and move to the C&P 

Exams tab (fig. 2-11y).  Since the veteran already has examination requests on file, the window 

will show the dates requested and completed. 

Fig. 2-11y 

Step 2 - Select the previous examination that was insufficient, and click View/Edit Selected 

Request. This opens the View C&P Exam screen (fig. 2-11z). 

Fig. 2-11z 
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Fig. 2-11bb shows the exams previously requested, and that they were completed. 

Fig. 2-11bb 

Step 3 – The user verifies that the correct request was selected, and then clicks the Add An 

Insufficient Exam Request button (fig. 2-11z). 

Step 4 - The Add New C&P Exam screen opens (fig. 2-11q, page 92).  The user completes this 

screen as directed in the Add a New Request Section above.  The only difference is that the list 

of available examinations is limited to the ones completed in the previous, insufficient 

examination (fig. 2-11cc).  These choices will only appear after the user enters the Routing 

Location. 

Fig. 2-11cc 

Step 5 – The user completes this screen and submits the examination request as directed in the 

Add a New Request section above. 

CAPRI GUI DVBA*2.7*123 User Manual November 2008 38 



 

        

 

  

    

 

   

 

    

   

 

 

 

 
 

 

     

 

 

  

     

 

 
 

Re-Print Final C&P Results 

This option is used to display final C&P examination results.  The user can print the results, if 

needed, by using File/Print after the results are displayed.  If the user attempts to use this option 

for an examination that has not been released to the Regional Office by the C&P Clinic, the 

following message is displayed: ―This request has not been released to the Regional Office yet.‖ 

Step 1 – The user logs into CAPRI, looks up the veteran using the patient selector, and moves to 

the C&P Exams tab. If there are no examination requests, the window is blank.  If the veteran 

already has examination requests on file, the window will show the dates requested, as in the 

example below. 

Fig. 2-11dd 

Step2 – The user selects the examination results and clicks the Re-Print Final C&P Results 

button.  

Step 3 - CAPRI displays a dialog box asking: Do you just want the lab/x-ray results? (fig. 2-

11ee).  The user clicks Yes for lab and x-ray results only, or No for the full examination results. 

Fig. 2-11ee 
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Step 5 - The Compensation and Pension Exam Report screen opens under the Reports tab (fig. 2-

11ff).  The user can scroll down for more results from the selected examination. 

Fig. 2-11ff 

Step 5 - To view the results of another final examination request, the user must go back to the 

C&P Exam tab and start from Step 2 above. 

Status Inquiry 

This option is used to check the status of any exam request shown on the C&P Exam tab screen. 

Step 1 – The user logs into CAPRI, looks up the veteran using the patient selector, and moves to 

the C&P Exams tab (fig. below). If there are no examination requests, the window is blank.  If 

the veteran already has examination requests on file, the window will show the dates requested, 

as in the example below. 

Fig 2-11gg 
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Step 2 – To check an exam’s status, the user selects the exam request and clicks the Status 

Inquiry button. 

Step 3 - The Compensation and Pension Exam Inquiry screen opens under the Reports tab 

(fig. 2-11hh).  The user can scroll down for more information about the selected examination. 

Fig. 2-11hh 

Step 4 - To check the status of another exam request, the user must go back to the C&P Exam 

tab and start from Step 2 above. 

7131 Request 

The 7131 Request tab includes functions such as: 

Adding new requests for 21-Day Certificates, Notices of Discharge, etc.  

Status inquiries and reports 

Viewing and editing pending requests 

*Note: 7131 requests are reserved for information that cannot be obtained directly through 

CAPRI, such as older records and retired records that may not exist in the electronic database, or 

other records in VHA’s Computerized Patient Record System (CPRS) that are unavailable in 

CAPRI.  For example, scanned records in CPRS may not be available in CAPRI.  

Pending requests are shown in the left column and completed requests are shown in the right 

column of the screen.  In the example below (fig. 2-11ii), the request is still pending for an 

Admission Report, and there are no completed requests.  When the tab is first opened, all 

pending and completed requests are shown, but none is selected.  The Status Inquiry and 

View/Edit Selected Request buttons are not available until a request is selected. 
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Fig. 2-11ii 

Fig. 2-11jj shows what an open 7131 request for an outpatient treatment record looks like.  The 

Date of Event displays O/P Activity when the 7131 request is not for an Admission Report.  

Fig 2-11jj 

Add a New Request 

7131 requests can be made for reports including: 

Patient records which may be retired after a long period of facility inactivity 

Patient records which only exist on paper 

VAF 21-2680 Aid and Attendance examinations that have been completed by the veteran’s 
health care provider 

Competency reports 

Asset information 

21-day certificates 

Records based upon hospital admissions such as discharge notices and discharge summaries 
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Step 1 – The user logs into CAPRI, selects a patient, and clicks the 7131 Request tab. The 7131 

Request screen opens (fig. 2-11jj). 

Step 2 – The user clicks the Add a New Request button at the lower left corner of the 7131 

Request screen.  A screen showing radio buttons to select either Outpatient/Activity (fig. 4-45a) 

or Admission (fig. 2-11kk) is displayed.  

Fig. 2-11kk 

Fig. 2-11ll 
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Step 3 – The user selects either Outpatient/Activity (fig. 2-11kk) or Admission (fig. 2-11ll) 

depending on which one most closely relates to the request.  If no admission is listed under the 

Select Admission Date, see fig. 4-45b, then an electronic 7131 Request cannot be submitted.  

*Note: Notice of Discharge, Hospital Summary, Certificate (21-Day), and Admission Report 

are NOT available if the user selects Outpatient/Activity. These options are only available if 

Admission is selected. 

Fig. 2-11mm 

Step 4 – The user checks the items to request.  The Patient Name, Requested By, Request Date, 

Date Last Status Changed, RO, and Admission Date are already completed. 

Step 5 – The user enters comments in the area provided with details concerning the request (fig. 

2-11mm).  A Release of Information Clerk at VHA must dig through old records in search of the 

user’s request and appreciates any help the user can give by being specific about the request. 

Step 6 – The user clicks Send 7131 Request and the request is transmitted. Or, the user can click 

Cancel Request (fig. 2-11mm).  CAPRI opens a dialog box asking the user to confirm the 

choice. 

Step 7 - To inquire about the status of a 7131 request or to generate a report for proof of a 

request to be placed in the claims file, the user selects the Status Inquiry option (fig.2-11jj). 
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Status Inquiry 

Step 1 – The user logs into CAPRI, selects a patient, and clicks the 7131 Request tab. The 

7131-request screen appears displaying any pending or completed 7131 requests (fig. 2-11jj). 

Step 2 – The user selects the 7131 request for clicks the Status Inquiry button (fig. 2-11jj). 

Step 3 - The following report opens under the Reports tab (fig. 2-11oo).  To check the status of 

another 7131 request, the user must go back to the 7131 Request tab and start from Step 2 above. 

Fig. 2-11oo
 

Step 4 – The user can print the report for the claim folder by choosing Print from the File menu.
 

View/Edit Selected Request 

Step 1 – The user logs into CAPRI, selects a patient, and clicks on the 7131 Request tab. The 

7131-request screen displays any pending or completed 7131 requests (fig. 2-11jj). 

Step 2 – To check the status, the user selects the 7131 Request clicks the View/Edit Selected 

Request button (fig. 2-11jj). 

Step 3 - The following screen displays all of the information entered in the 7131 request (fig. 2-

11pp).  The user clicks the Close Window button when finished viewing the request.  

View 7131 Request screen: 
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Fig. 2-11pp 

Step 4 - To edit the 7131 request, the user can do so on this screen at this time if the request has 

not been finalized.  The fields available for editing are the documents requested (Notice of 

Discharge, Hospital Summary, Competency report, etc.), the Outpatient Treatment Report Date 

Range, the Routing Location, and the Comments.  When the edits are complete, the user clicks 

Close Window to save the changes (fig. 2-11pp). 

CAPRI Reports (Patient-Specific) 

The Reports tab allows the user to make various patient inquiries, review registration and profile 

data, and request surgery reports for the selected veteran. 

Patient Inquiry 
This report provides demographic, eligibility, and treatment information about the selected 

patient. 

Detailed Inpatient Inquiry 
This report lists all of the patient’s inpatient admissions, with the date, time, and ward.  The user 

can select an admission and click OK to get detailed information about that admission. This 

includes admission and discharge dates, transfers between wards, care providers, and diagnosis. 
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C&P Exam Detail 
This report was moved to the C&P Exams tab. If attempting to use this report, the user is 

directed to that tab. 

7131 Detail 
This report was moved to the 7131 Request tab. If attempting to use this report, the user is 

directed to that tab. 

Additional Treating Facilities 
This report will show if the patient was treated at any VHA facilities other than the one currently 

connected to by the user. 

View Registration Data 
This report provides full demographic data, including military information, for the selected 

patient. 

Patient Profile MAS (Full) 
The following screen is the default - it specifies all dates, all appointments, all enrollments, all 

team information, all edits, all dispositions, and the means test. The user can change the 

generated report to exclude particular types of information by clicking No for that particular type. 

Surgery Report 
This option will generate a list of all available surgery reports for the selected patient. If the user 

selects a procedure from the list, the OK button is enabled. 

Other Patient-Specific Reports 
As noted below in the non-patient-specific reports section, if a veteran is selected prior to 

choosing Reports from the File menu, two of the reports have additional options.  The Reprint a 

21 Day Certificate and the Reprint a Notice of Discharge reports allow the user to choose 

either for a date or for the patient selected.  Please refer to the next section for details on the 

other reports accessed from File/Reports. 

Reprint a 21-Day Certificate 

This option is used to reprint a 21-Day Certificate for a particular patient.  When the File/Reports 

Menu is accessed after selecting a patient, the report dialog box includes that patient as a 

selection option.  If the user did not have a patient selected, the dialog box would not include this 

as an option.  The certificate produced is exactly the same as the original certificate.  ROC 119, 

which appears at the bottom of each certificate, stands for VA Form 119 - Report of Contact. 

Reprint a Notice of Discharge 

From time to time it may be necessary to reprint a Notice of Discharge for a patient.  When the 

File/Reports Menu is accessed after selecting a patient, the report dialog box includes that patient 

as a selection option. If the user did not have a patient selected, the dialog box would not include 

this as an option.  If the admission associated with the 7131 was deleted and notification already 

sent, a message is displayed.  The message includes the patient's name, Social Security number, 
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date and time of admission, notice that the admission has been deleted, and a recommendation to 

contact the medical center. 

CAPRI Reports (non-patient-specific) 

The non-patient-specific CAPRI Reports are accessed from File/Reports. 

C&P Exams Reports 

AMIS 290 

This option electronically produces the AMIS C&P report that was manually produced by the 

regional office. AMIS stands for Automated Management Information System. It is a general 

system of computer programs used to process management reports. The AMIS 290 report covers 

compensation and pension examination request activity. The regional office AMIS 290 

calculates the data based only on that specific regional office's requests. The average processing 

time reported on the AMIS 290 report now accounts for lost 2507 request processing time due to 

appointment reschedules at the request of the veteran. Processing time for an insufficient request 

will include the processing time of the original request. In addition to a hard copy being 

produced, this option allows the user to send a MailMan message either locally or via network 

mail. The mail bulletin will contain the same information that appears on the report. 

Fig. 2-11qq shows the output from the AMIS 290 report.  

Fig. 2-11qq 

The terminology below may help interpret the AMIS 290 and Insufficient Exam Report.  

Total pending from previous month: 

This is the total number of 2507 requests reported to MAS before the last day of the previous month that 

were not completed prior to the end of that month, or were completed prior to the end of that month and 

reopened. 
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Requests received for date range: 

This is the total number of requests that were not entered with a priority of exam equal to INSUFFICIENT 

and had a date reported to MAS that fell within the date range entered by the user. 

Exams returned as insufficient: 

This is the total number of requests that were entered with a priority of exam equal to INSUFFICIENT and 

had a date reported to MAS that fell within the date range entered by the user. 

Requests returned complete: 

This is the total number of requests that have a date released that fell within the date range entered and have 

a request status of COMPLETED, PRINTED BY RO or RELEASED TO RO, NOT PRINTED. 

Requests returned incomplete: 

This is the total number of requests that have a cancellation date that falls within the date range entered and 

a request status that equals CANCELLED BY RO or CANCELLED BY MAS. 

AMIS 290 by Division 

This is the same report as the AMIS 290 above, but the user can limit the report to a single 

division of the VHA facility that performs C&P examinations, such as a community-based clinic. 

Insufficient Exam Report 

The Insufficient Exam Report option prints a report of 2507 requests entered with a priority of 

INSUFFICIENT EXAM for a specified date range. The user may choose a detailed or summary 

version of the report. Only exam reasons and types that have information to report are included 

on the detailed version of the report. 

The summary version of the report is divided into two parts. The first part contains the total 

number of 2507 requests/exams received for the date range, the total number of priority 

insufficient requests/exams for the date range, and the percentage of insufficient requests/exams 

received. Due to the rounding of the component percentages, the total of the percentages may not 

equal 100%. The second part of the summary version is a breakdown of each reason an exam 

was returned. The detailed version allows the user to display one, many, or all insufficient 

reasons and AMIE exams. 

Other information provided includes exam type, patient name, Social Security number, and claim 

number. Provider and exam date on this report is the provider and date from the originally 

completed 2507. The exam date will not be included if the original 2507 has been purged. The 

length of the veteran's name and the provider are limited to 15 characters. If either field has been 

truncated, it will appear with two asterisks (**). If an insufficient 2507 is transferred from one 

site to another, that exam is reported on the insufficient exam report for both sites (original and 

remote). 

Pending C&P Exams 

This option will print out all pending C&P requests. The user may sort the reports by request 

status, routing location, veteran name, or age of the request. 

When sorting by status, the report can be tailored to identify NEW, PENDING, TRANSCRIBED, 

or ALL pending C&P exams.  Sorting by TRANSCRIBED may be useful for identifying ready 
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to rate claims that have been completed but not released to the RO.  Common delays for not 

releasing transcribed results include waiting for a physician’s signature and/or waiting for 
additional required tests or studies.  An inquiry to the VAMC C&P clinic can clarify reasons as 

to why TRANSCRIBED results have not been released if an excessive number of days have 

elapsed since the date of the C&P exam request.  

Each report displays the following information, if applicable: veteran name, Social Security 

number, claim number, request date, elapsed days, exams requested, and requester name and 

location. The total number of exams pending will also be provided. 

C&P Exams Checklist 

The Exam Check List for RO option is used to print a checklist used by regional office 

personnel to select compensation and pension examinations for veterans. The request worksheet 

lists the body systems and the exam worksheet names. It also contains a remarks section. The top 

portion of the work sheet allows the requester to enter veteran-specific information, including: 

Veteran's name, Social Security number, and C-Number 

VAMC where the exam is to be performed 

Veteran's day and night telephone numbers 

Power of Attorney 

Date the exam was ordered and by whom 

Insufficient exam date 

Re-Print C&P Final Report(s) 

This option allows the reprinting of final 2507 exams with the status of Completed, printed by 

RO. The reports are sorted by the last two digits of the claim number. The user must enter the 

date the report was previously printed. Reprinting a request is not allowed unless the person 

requesting the reprint has a division, which matches the station number of the requesting regional 

office. The exam must have the status Completed, printed by RO or Released to RO, not 

printed. The package is designed to print any lab/radiology results designated for C&P. When 

printing, the system will examine all lab/radiology results for 120 days before the release date. 

The output will include a summary portion that includes patient name, Social Security number, 

claim number, and request date. The total number of requests to be printed will also be provided. 

Exam Requests by Date Range 

This report will generate a simple list of all exam requests entered within the date range specified. 

The report is sorted by date of entry. The following fields are reported: SSN, Patient Name, 

Request Date, Date Released, Date Printed, and Status. The report was primarily created to assist 

VHA in tracking exams that may have been requested but not released. 

C&P exam Status comprises the following categories: 

New exam requests from VBA;
 
Pending, Reported exam requests acknowledged by VHA;
 
Exam requests Canceled by MAS;
 
Exam requests Canceled by RO;
 
Exam requests Released to RO, Not Printed; and
 
Exam requests Completed, Printed by RO.
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Hospital Adjustment Reports 

Admission Report for SC Veterans 

This option will report all service-connected admissions to the facility the user is connecting to 

for any given date range. Each time the report is processed and contains data, the date is captured 

and stored. It will then be displayed as the "last run date" for the next processing session. 

Information, which may be provided for each patient found, includes claim number, claim folder 

location, Social Security number, admission date, admitting diagnosis, discharge date, bed 

service, whether the patient is receiving A&A or pension, and eligibility data. Depending on the 

date range selected, this report could be quite lengthy. 

Admission Inquiry by Date 

This will create a report that matches the data generated by the AMIE option of the same name. 

It is a cumulative report comprising all admissions for a given date range.  The report is designed 

primarily to be an auditing tool for the RO.  Information which may be provided for each patient 

includes claim number, claim folder location, Social Security number, admission date, admitting
 
diagnosis, discharge date, bed service, whether the patient is receiving A&A or pension, and 

eligibility data.  Depending on the date range selected, this report can be quite lengthy.  


Step 1 - The user enters a date range using Stop date and Start date. 

Step 2 - A specific regional office is selected.  

Step 3 - Then, the user clicks OK.
 

The yellow informational box displays the last report that was generated either using CAPRI or 

the corresponding option in AMIE roll and scroll.  This can be used as a reminder when running
 
a new report of this type.
 

Fig. 2-11rr 
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Special Report for A&A/Pension 

This report option provides information on veterans receiving either pension or A&A.  The 

selectable patient movement types are limited to any active discharge types at the medical 

facility.  Some of the data elements include claim number, claim folder location, Social Security 

number, admission date, admitting diagnosis, discharge date, bed service, whether the patient is 

receiving A&A or pension, and eligibility data.  Depending on the date range selected, this report 

can be quite lengthy.  

The user selects one or more of the special report types by checking the box next to the report 

name.  Some of the choices are pre-selected to AMIE default settings, but may be unchecked to 

remove them from the final report.  Date range is the same in other CAPRI report options.  The 

report can be run for all regional offices or a specific one.  The default is for all offices.  After all 

selections are made, the user clicks the Run Report button. 

Fig. 2-11ss 

Re-Admission Report 

This report compiled information pertaining to any veteran receiving pension or aid and 

attendance who has been readmitted to a facility within 185 days of his or her last discharge date. 

The following criteria must be met for the patient to appear on this report: 

If the patient is in receipt of pension and Hospital is selected: readmitted within 185 days 

of last discharge and has a length of stay > 89 days. 

If the patient is in receipt of pension and Dom (Domiciliary) is selected: readmitted 

within 185 days of last discharge and has a length of stay > 59 days. 

If the patient is in receipt of aid and attendance and either Hospital or Dom is selected: 

readmitted within 185 days of last discharge, has a current length of stay greater than 29 

days, and last discharge was IRREGULAR. 
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Information provided may include veteran's claim number, claim folder location, eligibility, 

Social Security number, and whether or not in receipt of pension and/or aid and attendance. 

Admission data includes admission date, admission diagnosis, discharge date, discharge type, 

and bed service. 

Discharge Report 

This option will report service connected, A&A, pension, or all discharges for the facility the 

user is connected to for any given date range. Each time the report is processed and contains data, 

the date is captured and stored. It will then be displayed as the "last run date" for the next 

processing session. Information, which may be provided for each patient found, includes claim 

number, claim folder location, Social Security number, discharge date, type of discharge, length 

of stay, bed service, in receipt of A&A or pension, and eligibility data. Depending on the date 

range and number of discharge types selected, the report could be quite lengthy. 

Incompetent Veterans Report 
This option will report all veterans who have been ruled incompetent by Civil or VA authorities. 

For this report to run correctly, either the DATE RULED INCOMPETENT (VA) or DATE 

RULED INCOMPETENT (CIVIL) fields must have been edited by VHA personnel (OR) the 

RATED INCOMPETENT field in the PATIENT file must contain a YES value. Each time the 

report is processed and contains data, the date is captured and stored. It will then be displayed as 

the "last run date" for the next processing session. Information, which may be provided for each 

patient found, includes claim number, claim folder location, Social Security number, discharge 

date, type of discharge, length of stay, bed service, eligibility data, and date ruled incompetent. 

Depending on the date range selected, the report could be quite lengthy. 
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Request for Information Reports 

Pending Form 7131 Requests 

This report displays all requests that are not finalized. It lists only the items pending for each 

patient request. The elapsed days (total work days passed since the request was logged) is 

displayed which may be useful in keeping track of outstanding requests. The user may choose to 

sort the report by regional office number and division. If the user chooses to report for a specific 

division, any 7131 that has that division responsible for any portion of the request is included. 

Requests may appear on this report with no items listed as pending. These are requests where the 

final item(s) have been completed but the request itself has not yet been finalized by the system. 

This should be a rare occurrence. If this does occur, wait 24 hours to see if the auto-finalization 

program remedies the situation. If the auto-finalization program did not run, the user may use the 

Request for 7131 Information options to edit the request. The IRM Service of the medical center 

the user is connecting to should be notified if it appears that the auto-finalization program is not 

set to run. Since the pending report may serve many divisions or remote sites, the division, which 

is responsible for the completion of the request, is displayed at the top of each printed record. 

21 Day Certificate Printing 

This option is used to print 21-Day Certificates that were previously requested. They must have 

been completed and released by VHA before they can be printed. ROC 119, which appears at the 

bottom of each certificate, stands for VA Form 119 - Report of Contact. If the length of stay for 

the selected episode of care is 21 days or greater, a certificate is generated regardless of the 

request date. It should also be noted that upon generation of a certificate, the system will 

automatically modify the existing 7131 request for the veteran to show requests for a Notice of 

Discharge and Hospital Summary. This is done ONLY if they are not already requested, or were 

requested and previously completed. If there are no new 21-Day Certificates to print, CAPRI 

displays a message. The only prompt is for device selection. 

Reprint a 21-Day Certificate 

This option is used to reprint all 21-Day Certificates by the original processing date or an 

individual certificate if a patient’s CAPRI record has been previously selected. The user must 

know the date the certificate was originally printed to reprint by date. The certificate produced is 

the same as the original certificate. ROC 119, which appears at the bottom of each certificate, 

stands for VA Form 119 - Report of Contact. 

Reprint a Notice of Discharge 

Items such as a Notice of Discharge are automatically tracked and issued ONLY when the event 

occurs.  At that point, they become a 7132, Notice of Discharge. From time to time, it may be 

necessary to reprint a Notice of Discharge for a patient. This option allows the user to reprint 

notices for all veterans for a selected processing date. If the admission associated with the 7131 

was deleted and notification already sent, a message is displayed. The message includes the 

patient's name, Social Security number, date and time of admission, notice that the admission has 

been deleted, and a recommendation to contact the medical center. 
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VHA Reports 
Template Activity 

This report is specific to CAPRI and does not exist within roll and scroll AMIE. The primary 

intent is to assist VHA staff in tracking their site’s examination template use within CAPRI. The 
report corresponds to the C&P Worksheets tab within CAPRI, which VBA staff may or may not 

be able to see. This tab is locked with a security key not normally provided to VBA. 

Other Reports 
NOTE: The next two reports are a special type that is normally run only by a selected individual 

at the regional office. It is probable that these is locked with a security key in a future version of 

CAPRI to prevent accidental use. After these reports are run, flags are set within AMIE that 

update the report’s last date/time. If the report is accidentally run when it should not have been, 

any user could still generate the report again by using the re-print options, also available in the 

reports dialog box. 

Print C&P final Reports (Manual) 

The Print C&P Final Report (Manual) option allows printing of 2507 examination results sorted 

by the last two digits of the claim number. It will print only those requests that have been 

released to the regional office and not printed. This option will only be used by the regional 

office and should be executed only if there is no supporting paperwork to go with the final 

results (e.g., eye charts). The package is designed to print any lab/radiology results designated 

for C&P. When printing, the system will examine all lab/radiology results for 120 days before 

the release date. When a report is ready to be printed, it indicates that all exams for a particular 

request have been performed on the veteran (or canceled) and the results completed, transcribed, 

approved, and released. 

The output from this option will include the C&P final exam reports as well as a summary 

section. The summary section will list the patient name, Social Security number, claim number, 

and request date on each exam report that is printed. The total number of requests to be printed is 

also provided. Final C&P results may be received at the regional office in the following three 

ways: 

Direct printing - completed at the regional office through the use of this option 

FAX delivery - if there is supporting paperwork for the final results, the request is 

flagged as such when it is released. After flagged, the user will not be able to print it 

using this option. Only one original copy is printed at the hospital, and it is faxed along 

with supporting paperwork. This copy is stored in the veteran's folder (after being signed). 

Fax delivery of all paperwork ensures the entire exam is kept together. 

U.S. Mail - In cases where there is supporting documentation that would not FAX well, it 

is necessary to mail the entire package to the regional office. An example would be an 

eye exam that included several different charts. 

Print New Notices of Discharge 

Items such as a Notice of Discharge are automatically tracked and issued ONLY when the event 

occurs.  At that point, they become a 7132, Notice of Discharge. This option facilitates printing 

notices for all veterans since the last time the report was generated. If the admission associated 

with the 7131 was deleted and notification already sent, a message is displayed. The message 
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includes the patient's name, Social Security number, date and time of admission, notice that the 

admission has been deleted, and a recommendation to contact the medical center. 

The system is designed to automatically provide new notification of discharge in three cases: 

The veteran has a pending Notice of Discharge request logged on a 7131.
 
The discharge is by death.
 
The veteran is discharged to a community nursing home.  


The discharges at the site are checked nightly for ―today’s‖ date minus seven days. Processing 
this date range gives the hospital time to correct any errors that occur in the discharge process 

(e.g., wrong discharge type). 

If the admission associated with the 7131 was deleted and notification already sent, a message is 

displayed.  The message includes the patient's name, Social Security number, date and time of 

admission, notice that the admission has been deleted, and a recommendation to contact the 

medical center. 

If a specific date range is needed, use the re-print option under the Request for Info heading 

instead. 
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Admin Tab 

The Admin tab combines information about the patient’s address and appointments, including 
admissions (fig. 2-11tt).  

Address Tab 

The user can view the permanent address, view the temporary address, and view Past, Future, or 

All appointments.  Previous versions of CAPRI allowed the address to be edited.  This feature 

has been removed in version 91 and later versions of CAPRI.  The Edit Address Information 

button is inoperable for most users. 

Fig. 2-11tt 

NOTE:  The user can switch between the Address and Appointments tabs using the mouse cursor 

and clicking, or by depressing the ―Alt‖ key and the letter designation of the tab.  Example: 

depressing the ―Alt‖ and ―V‖ keys takes the user to the Address; ―Alt‖ and ―W‖ keys takes the 

user to the Appointments.  
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Appointments Tab 

The appointments tab shows the status of all of the patient’s past and future appointments, as 

well as admissions, based on the selections made by the user (fig. 2-11qq). If the appointment 

was cancelled, the status will show that the appointment was cancelled, by whom or the reason 

(such as CANCELLED BY CLINIC or NO-SHOW), and there is cancellation remarks indicating 

the reason for the cancellation.  

Step 1 - Click on the ―Admin‖ tab in CAPRI.  The Address screen opens (fig. 2-11tt). 

Step 2 - Click on the ―Appointments‖ tab on the bottom left, and the Appointments screen 

appears (fig. 2-11qq).  The default view is to show All Appointments. 

Fig. 2-11qq 

Step 3 - Click on ―Future Appointments‖ or ―Past Appointments‖ to show the desired 

appointments (fig. 2-11qq).
 
Step 4 - Click on ―Admissions‖ to see all past admissions (fig. 2-11qq).
 

Health Summaries Tab 

Health Summaries are customized reports comprised of VistA components specified by end 

users. Most of these summaries were developed by the VHA facilities. Regional Offices can 

create special summaries that will appear on the menu. VARO St. Petersburg, in cooperation 

with VISN 8, developed a Health Summary called VARO Rating, which contains components 

specified by RVSRs to facilitate their work process. To develop a custom Health Summary, the 

user must contact the VHA facility’s Information Resources Management (IRM). The VARO 
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Rating Health Summary in VISN 8 facilities include the following VistA components: 

demographics, imaging impressions, past and future clinic appointments, admissions and 

discharges, discharge summaries, progress notes, surgery reports, and medications. In addition to 

the reports on the menu, the user can create one-time Ad Hoc reports for use with a particular 

case. 

Programmed Summaries 

Step 1 – The user logs into CAPRI, selects a patient, and clicks on the Health Summaries tab. 

The following screen opens (fig. 2-12): 

fig. 2-12 
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Step 2 - The left column shows all the various programmed Health Summaries available at the 

medical facility to which the user is connected (fig. 2-13). This menu will vary from facility to 

facility. The user uses the scroll bar to find a specific health summary. There are many useful 

health summaries that have been created at the user’s medical facility. This example pertains to 

the VARO Rating health summary that was created in VISN 8 (fig. 3-14). 

The user scrolls down to the Health Summary clicks its title in the left column. The report is 

automatically generated for viewing in the window on the right. 

*Note: If unsure what components are in a particular summary, the user can generate the 

summary and then click the down arrow to the right of HS Component field. A drop-down list 

will appear listing the components. 

fig. 2-13 

Step 3 - To view, the user scrolls the page with the scroll bar function to see the various 

components of the custom health summary. The components appear in the order that they are 

listed in the component box (opened by clicking on the down arrow) (fig. 2-13). The user can 

change the width of the summary window by clicking on the center dividing line and dragging it 

to the side. 

Step 4 - To print, use File/Print from the CAPRI menu bar. 
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Ad Hoc Report 

Step 1 - Log into CAPRI, select a patient, and click on the Health Summaries tab. The following 

screen opens (fig. 2-14): 

fig. 2-14 

Step 2 – When the user clicks the Adhoc Report button, the Adhoc Health Summary screen is 

displayed (fig. 2-15). 

fig. 2-15 
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Step 3 - The list of available components appears in the left column (fig. 2-15). The user can 

order these components by their Name, Abbreviation, or Display Header. The user can scroll 

down the list, or the user can type the first few letters into the box directly above the list. The 

user locates the component to add and then clicks the > button to move that component into the 

center column. 

Step 4 – After the user has more than one component in the center column, the up and down 

arrow buttons are available. These buttons are used to change the order that the components 

appear in the report. The user selects the component, then clicks the arrow to move the 

component up or down in the list. If a component was selected in error, then the (<) button can 

be used to remove it from the list. The (<<) button removes all selected components from the 

middle column. Depending on the component selected, the Occurrence Limit and Time Limit 

fields may be available. In the example below (fig. 2-16), the component Discharge Summary 

has an Occurrence Limit of 10 summaries, and only summaries within the past 1 year is 

displayed. 

fig. 2-16 

Step 5 – After selecting all the components needed in this report, the user clicks OK. The report 

is generated in the right window of the Health Summaries tab (fig. 2-17). The HS Component 

drop-down list shows the components selected if the user clicks the down arrow. 
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fig. 2-17 

Step 6 - To print, the user selects Print from the File menu. 

Remote Data View 

CAPRI now includes remote data views. Within the Health Summary tab, clicking the Remote 

Data View button allows CAPRI to identify all VA medical facilities where the patient has been 

treated and identify the last time the patient was treated at that facility. Place checks in the boxes 

next to the facilities where the user would like CAPRI to assemble Health Summaries. No 

additional accounts or sign-ons are necessary. 

Step 1 – The user logs into CAPRI, selects a patient, and clicks the Health Summaries tab 

Step 2 – The user clicks the Remote Data View button 

Step 3 - CAPRI identifies the remote sites where the patient was treated (fig. 2-18). 
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fig. 2-18 

Step 4 – The user checks the box next to the sites from which health summaries are needed (fig. 

2-18). 

Step 5 - After identifying all facilities where Health Summaries are desired, an expanded list of 

Health Summary types appear in the left window (fig. 2-19). 

fig. 2-19 

Step 6 - After the selected Health Summary has been assembled at all selected sites, CAPRI 

displays a message that the task has been completed (fig. 2-20). Successful completion of these 

remote data views is highly dependent upon the performance of the VA Wide Area Network. 
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fig. 2-20 

** NOTE ABOUT REMOTE DATA VIEW AND CAPRI IN REMOTE MODE ** 

Remote Data View is not available when CAPRI is running in remote mode. Instead, an Other 

Facilities Visited button is available at the top left of the main CAPRI window. (fig. 2-21) 

fig. 2-21 

Clicking the Other Facilities Visited button presents a selector that displays other VHA sites 

where the patient may have data (fig. 2-22). The user chooses an alternate site and selects Switch 

to This Facility. The current connection is dropped and the user is connected to the new site. 

The same patient is selected for the user. If the user does not normally have privileges to connect 

directly to the new site, then the user will be unable to select a patient. To select a new patient, 

the user must use the Other Facilities Visited button and return to a site to where the user has 

patient selection privileges. 
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fig. 2-22 

Clinical Documents Tab 

When the user selects the clinical documents tab (fig. 2-23), another complete set of tabs opens 

along the bottom of the screen which allows navigation within various components of the
 
veteran’s electronic medical records. 

Clicking on the Clinical Documents tab yields access to: 


Notes (progress notes) 

Discharge Summaries 

Consults 

Vitals 

Medications 

Laboratory findings 

Imaging (x-rays, CT, MRI, etc.) 

Dietary restrictions 

Nutritional Assessments 

Physician’s Orders Summary 
Procedures (Holter monitor, echocardiogram, electrocardiogram, thallium stress test, etc.) 

Problem List 

Each item found is listed in the left column. If the user hovers the mouse pointer over an item, 

more information is displayed. In fig. 2-23, the pointer was over a completed Multidisciplinary 

note, and that information appeared. The selected note, directly above it, is a nursing note, which 

appears in the window on the right. The user can resize these windows by moving the dividing 

bar.  The search box in the lower right allows the user to perform a simple search on the 

electronic notes for a word or phrase. Any time the search item is found, it is highlighted in the 

note (in this example, low back pain was used). Please note that the search is not case-sensitive 

and the user can use partial words for a wider search. For example, using ―diab‖ as the search 

term will find all permutations, such as ―diabetes,‖ ―diabetic,‖ and ―Diabinese.‖ 
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fig. 2-23 

Note:  While the Clinical Documents tab is selected, the twelve electronic medical records tabs 

(fig. 2-23) can be accessed by clicking a tab or by depressing the ―Alt‖ key and the number or 
letter designation of the tab.  Example: depressing the ―Alt‖ and ―1‖ keys takes the user to the 

Notes; ―Alt‖ and ―z‖ keys takes the user to the Problem List.  

Current View 

CAPRI allows the user to choose the view of available documents (fig. 2-23). The Current 

View option button is located below and to the right of the circled Clinical Documents tab in fig. 

2-23. The user can choose All Documents, Search by Number of Documents, and Search by Date.
 
If the user uses the Search box, a list of Searched Documents is displayed, as in the example
 
above. 


Step 1 – The user begins by clicking the button to the right of the Current View label (fig. 2-23).
 
The following dialog box opens (fig. 2-24):
 

fig. 2-24 
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Step 2 – The user specifies the type of Search (fig. 2-24). To search by date, the user enters the 

Start Date and Stop Date, and clicks the Search By Date button. The search is performed and the 

Current View changes to (fig. 2-25): 

fig. 2-25 

To specify a particular number of documents, enter that number in the box under Number of 

Documents (fig. 2-25). The user can type the number or use the up and down arrows. After 

specifying the desired number, the user clicks the Search by Number of Documents button. 

The search is performed and the Current View changes (fig. 2-26): 

fig. 2-26 

To search for all documents, the user clicks the All Documents button (fig. 2-24). The search is 

performed and the Current View changes (fig. 2-27): 

fig. 2-27 

Report Builder 

The Report Builder allows the user to build a custom report by clicking on a selection from the 

appointment list on the left and then clicking the Add Current button. For example, if the 

veteran’s claimed issue is a cardiovascular disability, the user can select all of the cardiology 

notes and related consultations to build a custom report to facilitate the rating decision. To clear 

this custom report, click the Clear List button. 

The Report Builder has been updated with an Add All function. Depending on what type of data 

is being displayed, the button allows all listed reports to be automatically selected for printing 

and viewing (fig. 2-28). 

fig. 2-28 
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If the user selects Add All, CAPRI downloads all available reports one by one. The user has the 

option to stop this process at any time by selecting Stop Adding (fig. 2-29). After the individual 

reports have been downloaded, the user can change the order of the reports using the Move Up 

and Move Down buttons, delete individual reports using the Delete One button, and build the 

final report with the Build button.  After the report has been built, it can be printed by selecting 

the Print option from the File menu.  

fig. 2-29 

Notes tab 

This tab allows the user to view or print the veteran’s progress notes (fig. 2-30). The left side of 

the screen shows the appointment date, type of progress note, and the author of the note. If the 

user places the mouse pointer over a progress note, the full title is displayed. When a note is 

selected, it will appear in the right window. Fig. 2-30 shows the selected domiciliary progress 

note, while the title of the orthopedic consultation note is shown because the mouse pointer was 

placed over it. The right side of the screen shows the contents of the selected progress note. The 

windows can be expanded or minimized to enhance viewing. Contents may be viewed, printed, 

or copied and pasted into a Windows-compatible document such as Microsoft Word or as part of 

a rating decision. 

fig. 2-30
 

The standard Notes list is displayed in descending chronological order (fig. 2-31):
 

November 2008 CAPRI GUI DVBA*2.7*123 User Manual 69 



 

        

 
 

    

 

 
 

 

  

 

 
 

  

 

   

  

 

fig. 2-31 

If the user clicks the Divisions button (fig. 2-32), the list is re-displayed showing the division of 

the VHA facility for each note. In fig. 2-32, there are notes from the Ft. Myers clinic (FT) and 

the Collier CBOC (COL). 

fig. 2-32 

Discharge Summaries tab 

This tab allows the user to view, print, or copy and paste information from the veteran’s 

Discharge Summaries (fig. 2-33). The left window lists the dates of discharge and the right 

window displays the selected summary. The Discharge Summary tab will download all available 

discharge summaries. The divider between the left and right windows can be moved left or right 

to resize the window. 

fig. 2-33 

Consults tab 

This tab allows the user to see consultation reports for the patient (fig. 2-34). Available 

consultations are listed on the left. If the user places the mouse pointer over a consultation, the 

full title is displayed. When a consultation is selected, it will appear in the right window. Fig. 2-

34 shows the selected dietician consultation. The title of the dermatology consultation is shown 

because the mouse pointer was placed over it. 
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fig. 2-34 

Vitals tab 

This tab allows the user to display the vital signs measured during the veteran’s clinical visits 

(fig. 2-35). Vitals can be displayed by the various time periods shown in the left window.  In fig. 

2-35, all of the vitals for the past five years are displayed.  Blood pressure readings are especially 

handy for hypertension claims.  Other components included in vitals are temperature, pulse, 

respiration, height, weight, and pain index. 

fig. 2-35 

Clicking the Graph Report button opens another window where the user can select a particular 

vital sign (blood pressure, body mass index, height, pain, pulse, respiration, temperature, and 

weight) to generate a graph (fig. 2-36).  This can be useful when evaluating conditions such as 

hypertension. The user can use this for reference, or copy the graph using the Copy Graph to 

Clipboard button and then paste the graph it into a document. 
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fig. 2-36 

Medications tab 

On the Meds tab, the user can display all of the medications prescribed to a veteran in several 

formats, as shown in the left window (fig. 2-37).  The user can choose between active and 

inactive prescriptions as well as inpatient or outpatient prescriptions.  Information includes all of 

the veteran’s prescriptions, the prescribing physician, the status of the prescription, and dosage 

instructions. The display format Outpatient Rx Action Profile shows the classification of the 

prescribed drug, which can save users time in referencing a prescription in the Physician’s Drug 
Reference (PDR). 

fig. 2-37 

Laboratory tab 

This tab shows various laboratory findings including blood, urine, anatomic pathology, blood 

bank, and microbiology findings (fig. 2-38). This tab may be helpful in finding a confirmed 

diagnosis for cancer from a biopsy or in evaluating diabetes-related or HIV-related illness. 
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fig. 2-38 

Another function under the Lab tab is the graph function, which can graphically display 

laboratory findings as specified by the user (fig. 2-39). This feature does not have a separate 

button, as on the Vitals tab. Instead, the graph function is included in the list in the left window 

(fig. 2-38).  In fig. 2-39, a graphic display of the veteran’s plasma sodium levels from 02-04-99 

to 04-21-03 is shown.  Note that the normal values are displayed on the screen (the red lines at 

137 and 145).  The user can scroll through numerous laboratory tests which are available in the 

left window.  Some of the items that could be graphed include the CD4 count if a user is working 

on a claim for HIV- related illness or the Prostatic Specific Antigen level if the claim is for 

prostate cancer. 

fig. 2-39 

Imaging tab 

The Imaging tab includes images from x-rays, MRI, CT scans, ultrasounds, cardiac perfusion 

imaging, and bone scans (fig. 2-40). The left window shows the various imaging techniques 

performed on the veteran and generally indicate the part of the body scanned or the name of the 
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scanning technique in the title to enhance the search for items specific to the claim. If the user 

places the mouse pointer over an item, the full title is displayed. When an imaging report is 

selected, it will appear in the right window. Fig. 2-40 shows the selected CT Scan of the Head, 

while the title of the ultrasound of both kidneys is shown because the mouse pointer was placed 

over it. 

fig. 2-40 

Diet tab 

The Diet tab can provide insight into a veteran’s special dietary restrictions and may be useful in 

claims for diabetes, eating disorders, or digestive conditions (fig. 2-41). The Diet tab is for 

current inpatient activity only. 

fig. 2-41 

Nutritional Assessment tab 

Like the Diet tab, this tab can provide insight into a veteran’s special dietary restrictions and may 
be useful in claims for diabetes, eating disorders, or digestive conditions (fig. 2-42). The 

Nutritional Assessment tab is for outpatient activity. All available assessments are listed in the 
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left window. The user selects the assessment date from the left window and it is displayed in the 

right window. 

fig. 2-42 

Order Summary tab 

The Order Summary tab shows all physicians’ orders for the patient for a selected time frame 
(fig. 2-43). The user chooses the time frame on the left (each selection is from today back 

through the period specified). The orders appear in the right window. In fig. 2-43, there are 

orders for an Optometry consultation, medication, and lab tests. 

fig. 2-43 

Procedures tab 

On this tab, the user can view the results of specialty tests such as cardiac catheterizations, Holter 

monitors, electrocardiograms, and thallium stress tests (fig. 2-44). If the user places the mouse 

pointer over a test, the full title is displayed with an indication of whether the test was normal or 

abnormal. When a test is selected, it appears in the window on the right.  Fig. 2-44 shows the 

selected Holter monitor test. The title of the echocardiogram is shown because the mouse pointer 

was placed over it. According to fig. 2-44, the echocardiogram’s result is abnormal. 
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fig. 2-44 

Problem List tab 

This tab displays all of the confirmed diagnoses for which the veteran is being treated (fig. 2-45). 

The list can display both active and inactive problems. This list can be especially useful in claims 

for NSC pension if the user is looking for confirmed diagnoses for which the veteran is being 

treated. This list serves to guide the user in the search of progress notes. In the example below, 

active diagnoses are marked with an ―A‖ and the inactive diagnosis is marked with an ―I‖. 

fig. 2-45 
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Compensation and Pension Worksheet Module 

Overview: 

The C&P Worksheets tab provides access to a defined set of point and click templates used for 

documenting Veteran’s C&P examinations. This functionality is commonly referred to as C&P 

Worksheets Module or CPWM. 

fig. 2-46 

Users who need access to this tab in the Compensation and Pension Record Interchange (CAPRI) 

must have the appropriate security key allocation before the tab is visible and functions become 

active (See User Setup section below). Users at the Veterans Benefits Administration (VBA) are 

typically unable to access this tab and are prevented from seeing a document before it is signed 

and finalized by the exam provider. 

User Setup: 

Security Key Assignment 

To activate CPWM for a particular user, a menu option and several security keys must be 

assigned. IRM will need to coordinate with the C&P clinic to determine what keys a user should 

receive. The majority of users will need 2 new keys. The reviewer type user will need 3 keys. 

1.	 DVBA CAPRI GUI– This is the option context to the main CAPRI application. All 

CAPRI users will need to be assigned access to this menu option. 

2.	 DVBA CAPRI WORKSHEET TAB – This security key makes the C&P Worksheets 

tab visible inside CAPRI. All Veterans Health Administration (VHA) CAPRI users 

should get this security key. 
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3.	 Some sites require the exam to be sent to a reviewer when complete. 

ONE of the following security keys must be assigned for anyone who is creating new 

C&P exam templates with CPWM. 

a. DVBAB CPWM DISALLOW REVIEW – User does not need their documents 

reviewed prior to release. 

b. DVBAB CPWM OPTIONAL REVIEW – User can choose to send some documents 

for review and not other documents. 

c. DVBAB CPWM REQUIRE REVIEW – User must have all documents reviewed by 

a reviewer prior to upload. 

4.	 OPTIONAL Key – If the site chooses to use the review process, users designated as a 

reviewer must be assigned the DVBAB CPWM REVIEWER security key 

It is imperative that a user not be given every DVBA* key. The keys have conflicting uses and 

unexpected results will happen. If users are unsure of the keys to assign, they should contact the 

national VistA helpdesk. 

Site Considerations: Review Functionality 

Before implementing the CPWM worksheet modules, sites should consider the business roles of 

each user who is accessing the system. The CPWM module can be configured several ways, 

depending on site preference and business needs. Each site should carefully consider the 

following configuration options. Examinations can be completed through one of the following 

paths. 

1.	 If the provider is allowed to Sign and released to the RO and CPRS upon their 

completion without review by another party, the user should be assigned Security
 
Allocation Key DVBAB CPWM DISALLOW REVIEW.
 

2.	 If the provider will need to Send the template to a reviewer for approval before 

completion, the provider should be assigned DVBAB CPWM REQUIRE REVIEW. 

3.	 If the provider will have the option to Send the template to a reviewer or sign and release 

immediately, the provider should be assigned Security Allocation Key DVBAB CPWM 

OPTIONAL REVIEW. 

The following screens demonstrate what a user will see at the bottom of their screen when 

working with a CPWM document with the assigned security key. 

1.	 DVBAB CPWM DISALLOW REVIEW -

fig. 2-47
 

Note that the Send for Review button has been grayed out and cannot be selected.
 

2.	 DVBAB CPWM OPTIONAL REVIEW – The user can choose whether to send a 

document for review or not. 
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fig. 2-48
 

Note that both the Send for Review and Done! buttons are active.
 

3.	 DVBAB CPWM REQUIRE REVIEW - All of the user’s documents require a review 

prior to going into AMIE and TIU. 

fig. 2-49 

Note that the Done! button is grayed out. 

C&P Worksheet Tab Functionalities 

Work Sheet Status 

The C&P Worksheets tab contains the list of pending and completed worksheets for the selected 

patient, if any exist. Information provided includes template (worksheet) name, author, 

worksheet status, and the date the worksheet data was sent to CPRS (where applicable). Statuses 

include the following. 

Draft/Not Ready - worksheet has been started but not completed. 

Review Pending - worksheet has been sent for review. 

Sent Back - worksheet has been sent back to the clinician by the reviewer for changes. 

Complete - worksheet has been completed and the data sent to CPRS on the date shown. 

Uncosigned – worksheet has been signed by the author but the author requires a cosigner in 

CPRS 

Opening a CPWM Exam 

The user may open a pending template in the C&P Worksheet tab display by selecting it and 

clicking on the Display Template button or by double-clicking. All templates with Complete 

status are viewable, but the user may view only his or her own unsigned templates without 

Reviewer access. 

Deleting a CPWM Exam 

The user may delete any pending template in the C&P Worksheet tab display by selecting it and 

clicking on the Delete Template button; the user is prompted to verify the deletion by entering a 

number that appears in the verification window. The user will only be able to delete his or her 

own templates without Reviewer access. Templates with status of complete cannot be deleted. 

Copying an existing CPWM Exam 

To copy a pending CPWM template, click the template name on the list, then click the Copy 

Template button. The system displays a prompt ―Would you like a NEW copy of the selected 
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template and assign it to yourself?‖ After the user click Yes, the template is copied and assigned 

to the current user. 

Refresh the list 

The user may update the C&P Worksheet tab display for the selected patient by clicking on the 

Refresh List button. The refresh function will normally happen automatically, but it may be 

performed manually as well. 

Flagging 

Three visual flags are available on the C&P Worksheets tab and the unsigned templates dialog 

box. Exam templates that are "new" will have an "N" flag. After is it viewed, the flag clears 

automatically. A green flag and red exclamation mark are available to be used according to user 

needs. These flags can be toggled on and off by right clicking any template name displayed on 

the C&P worksheets tab or unsigned template dialog box, then selecting toggle on/off. 

Starting a New CPWM Exam 

To create a new exam, click the New Template button. (The user must have the required security 

key to create a new worksheet). 

fig. 2-50
 

The Browse Templates screen appears. (fig. 2-51)
 

fig. 2-51 
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Step 1 - The user may select a single template or multiple templates by double-clicking (or by 

clicking the Add this template button) on the desired templates from the Available Templates 

list box. The templates that will make up the exam will appear in the Selected Templates list box.  

If the user select multiple templates, the system will merge the selected forms into a single form. 

The Description field displays information about the template version and the last date that the 

template(s) were updated. 

Used Buffer Space indicator is used to determine the number of templates that can be merged 

together into a single form. Complex templates, such as General Medical, will use more of the 

buffer than simple templates, such as Audio. Depending on the speed of your PC, the user may 

see slower performance if the user create a merged template that is using a large amount of the 

available buffer space. If the user uses up all of the available buffer space, CAPRI displays a 

message asking the user to remove some of their templates. 

fig. 2-52 

Step 2 - Enter data on the form (fig. 2-52) by clicking on the tabs and completing the fields. Tabs 

and fields is specific to the selected templates. If there are required fields on the template and 

they are not completed, the user is notified either while using the form or prior to signature. To 

review what was entered, the user clicks the Preview button. 

After the exam data entry is complete, According to the user’s assigned security allocation key, 

the user will have the option to select, Done, Send for Signature or Send for Review in order to 

complete the template. 

No review process - Done is active, Send for Review is deactivated. 

Review process optional - Done is active, Send for Review is active. 

Review process required - Done is inactive, Send for Review is active. 

For the reviewer, when the Template is in a Review Pending status, the user will have the option 

to send for signature or to select Done to complete the template. Selecting Send for Signature 

allows the user to designate the signer. 
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Step 3 – If the Done button is clicked, a preview of the report data that has been entered on the 

template is displayed. This represents what the final document will look like in CPRS. To make 

any changes, click the Cancel button to return to the template; otherwise click the OK button. 

fig. 2-53 

Step 4 – After Done is selected, the signature validation screen is displayed (fig. 2-53). The user 

are required to either select an appointment or admission date or specify that there was no 

appointment to continue. After a selection is made, the remainder of the fields on the Signature 

Validation screen will appear. 

TITLE: Title selection is required. The dropdown list for titles will only display titles that 

contain the words "C&P" or "Compensation and Pension" in the title name. 

EXPECTED COSIGNER: Users may or may not require a cosigner based on their clinical 

privileges. Cosigner information from CPRS (Authorization Subscription Utility) is respected 

inside CAPRI. To set a user up with a cosigner, contact IRM or your site’s Clinical Applications 

Coordinator. The basic rule is that a title-requiring cosignature in CPRS requires a cosigner in 

CAPRI as well. There are no cosigner specific keys or setup that is unique to just CAPRI. 

Step 5 – The user must select the correct request under Requests Available. A list of the open 

exams for that request is displayed. Note that all open exams must be cancelled or completed 

before release of the report can occur. 

Only examinations containing no exam report are offered as selections under Open Exams after 

selecting an open AMIE exam request. If an expected exam is not listed, a possible reason could 
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be that the exam already has either a partial or a complete transcription. The transcription can be 

removed by the appropriate clinic staff and CAPRI displays that exam request as a selection. 

If there is an open request but no exams are available, then all requested exams have been 

populated with either a template or transcription but the request has not yet been released. The 

request will need to be released through either CAPRI or AMIE by clerical or supervisory staff. 
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CPWM Worksheet Functionality 

The functionalities detailed in this section are functions that are only available when a CPWM 

worksheet is open for editing. After a worksheet is opened, there are several tabs and options 

available. By clicking on the visible buttons, the user can open other parts of the worksheet. 

Data Entry Functionality 

Each free text area contains the following options for data entry. The shortcut menu pictured 

below is available when the user right click in an area where free text data can be entered. 

fig. 2-54 

Load Exam Request Comments 

When the user right clicks in a free text field, an option to Load Exam Request Comments is 

available. To assist users with copying information entered on the exam request into a data entry 

area of the template, the user can select Load Exam Request Comments from the shortcut menu. 

When Load Exam Request Comments is selected, a separate window displays the list of Open 

exam request and the exam request comments. After selecting the desired exam request, the user 

can select the Insert these Comments button to paste the comments to a free text area of the exam. 

fig. 2-55 

Cut/Copy/ Paste functionality 

The shortcut menu in the free text fields give the user access to standard windows Undo, Cut, 

Copy, and Paste functionality. 
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Details Bar 

A details bar is available on each free text area in each template. The details bar is designed to 

provide users with a larger data entry area. Details bar becomes visible when the mouse is over 

the text box. After the user clicks the details bar a larger window is displayed, the user can then 

type the information desired and save/close the details box. When the details box is closed, the 

information is displayed in the original free text area. 

Spell Check 

A spell check feature is also available from the shortcut menu (fig. 2-56). Use the shortcut menu 

by right clicking inside the text box where the user’s data is entered. The spell check feature will 

search the current text area for misspelled words and return a list of suggestions for the 

misspelled words. If the spelling is OK, a message will display ―No errors found‖. 
The Spell checker allows the user to select from a list of suggested changes or make a change
 
using the Change to edit box. The user may also add a word to a custom dictionary by selecting
 
Add to Dictionary or reset dictionary to the original state.
 
*Note only the text area currently being edited is checked, not the entire template.
 

fig. 2-56 

Button Color Changing 

Button functionality has been enhanced to allow an end-user to set the color of buttons on a 

template.  The purpose of this modification is to allow CAPRI users to mark certain template 

sections (i.e. buttons) with a specific color to notate a particular need (e.g. come back and finish 

section later). The color of the button will then be maintained between sessions.  The color menu 

can be found by right-clicking on the desired button. 
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fig. 2-57 

Options button functionality details 

The Options button displayed on the bottom of each worksheet provides additional template 

management functionality 

fig. 2-58 

Manage Templates 

CAPRI users can select to add additional templates to a template that is already in use or delete a 

template from a group of merged templates by selecting Manage Templates on the Options menu. 

When a user selects Options and then Manage Templates, a dialog box is displayed to allow the 

user to select templates to add or templates to delete. There must always be at least one template 

remaining in the manage templates dialog box. An entire list of templates from a set or group of 

merged templates cannot be deleted without having one of the original templates remaining on 

the list. 

CAPRI will warn users when they have selected too many forms to merge by displaying a 

warning message ―You’ve selected too many forms. Either remove some of the new ones or 
choose existing ones for deletion‖.  Buffer must be less than 100% to complete the manage 
templates function. 
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fig. 2-59 

Change Exam Tab Order 

When users have several templates merged into one exam, the Change Exam Order feature can 

be used to customize the order in which templates are displayed. By selecting the Options button, 

then selecting Change Exam Tab Order to display the Form Exam Tab Order window, use the 

Move Up/Move Down buttons to move the exams into the desired order, click the OK button 

after templates are in the desired order. The templates and report is displayed in the customized 

order. 

fig. 2-60 

Restore Previous Version 

When a user is actively editing a template for a selected patient, the user can select Options and 

Restore Previous Version to view a history of the number saved entries for the template currently 

being edited. A dialog box, displaying the history of each time a template was saved, is displayed. 

The user can select the date/time of the save. CAPRI displays the name or names of the forms 

saved, date time, the name of the person who performed the save and the names of the 

template(s) that were saved at the selected date/time. The user can then select Load Selected 

Version; CAPRI will then load the templates and all data saved to the template or templates at 

the date and time in history. 
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fig. 2-61 

Review Events Comments 

If a template has had review comments added, users can view the reviewer’s comments at any 
time while a template is open for editing by selecting the Options button then Review Events. 

The Review Events window is displayed and users can then drag the Review events window to 

the side for viewing while continuing to edit the open CPWM Template. The comments for a 

given date/time can be viewed by selecting the date/time from the drop down list. 

fig. 2-62 

Info 

The info box will provide information about the template version and date of last update. It will 

also display which version of the CAPRI GUI that was last used to save the template. Script 

variables and Object count information may be used by technical staff for troubleshooting 

technical problems with templates. 
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fig. 2-63 

Generate Blank Template 

The Generate Blank Template feature allows the user to print a blank copy the current template 

that includes all primary questions. 

fig. 2-64 

Saving Template Data 

Autosave 

The data is automatically saved by the system every 8 minutes. Although the data is saved 

automatically, it is a good practice for the user to manually save work often. 

Manual Saves 

fig. 2-65 
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Click the Save button to manually save the data. When the manual save box is displayed, users 

can enter a customized description by typing a custom name in the box where manual save 

appears. Forms do not have to be completed in a single session. If the user closes a form without 

signing, CAPRI will retain all responses and save it for completion later. 

Saving after selecting Close 

When the worksheet is closed, using the Close Button, the user is prompted to Save and Exit or 

Keep Working. If Yes is selected, CAPRI will save the information currently entered on the 

Template. If No is selected, CAPRI will return the user to the Template and no save point is 

created in the save history. 

fig. 2-66 

Reviewer Key Functionality 

Users who have been assigned the Reviewer security key will have reviewer specific buttons 

inside a CPWM template. 

fig. 2-67 

Clicking the Send for Signature button allows the reviewer to select a signer for the document. 

The document will then be sent to the person who is authorized to complete the upload process. 

If there is a problem with the document, the reviewer can communicate with the original author 

by clicking the Review Events button. If this button is clicked, the Review Events dialog box is 

displayed (fig. 2-62). 

The reviewer can browse previous activity on the document by selecting entries under the 

Date/Time field, if there are any. To create a new review event, the reviewer clicks the Add 

New Send Back Event button. The top three fields are set automatically. The reviewer places 

any communication to the author in the Sent Back Comments field. When the Send Back Now 

button is clicked to complete the transaction, the status of the document is changed to Sent Back 

and the original author receives a notice the next time they log into CAPRI. The reviewer’s 

comments are the first thing seen when working with the sent back document. 

If a reviewer has been selected to sign a document by another reviewer, he or she will see the 

following prompt when displaying that document with CPWM. 
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fig. 2-68 

Additional Considerations 

A reviewer can display any document in CPWM, even if it is unsigned. Users who do not have 

the DVBAB CPWM REVIEWER key can only view signed documents or unsigned documents 

that belong to them. 

Sending a CPWM Exam for Review 

While sending a template for review, users have the option to send comments at the time the 

exam is sent for review. When a user selects the Send for Review button in an open template, he 

or she is prompted with an additional option of Yes, with a comment to the reviewer. 

fig. 2-69 

Choosing the option Yes, with a comment to the reviewer opens the Send Reviewer a 

Message box. The user enters comments in the comments box and then clicks Send to Reviewer 

Now. 

fig. 2-70 
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Status of Exam Changes to Review Pending 

fig. 2-71 

Sending a CPWM Exam for Cosignature 

Cosignature Required:
 
As previously described, CAPRI will respect the CPRS (ASU and TIU) business rules for
 
cosignature. If a user is set up to require a note signature, the signature screen will appear as in 

fig. 2-72 after a title has been selected.
 

If cosignature is required and the cosigner box is not active for a particular user, IRM or the 

site’s Clinical Application Coordinator should be contacted for assistance. 

fig. 2-72 

Clicking the box under EXPECTED COSIGNER allows the user to select or change a 

previously selected cosigner. A confirmation dialog box will appear as in fig. 2-73. 
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fig. 2-73
 

The user should verify that the correct cosigner is being selected. The cosigner should cosign the 

document directly in CAPRI to prevent use of the cosignature transfer utility.
 

Sending a CPWM Exam for Signature
 
Clicking the Send for Signature button allows the reviewer to select a signer for the document. 

The document will then be sent to the person who is authorized to complete the upload process.   


CPWM Exam Management functions 

Unsigned C&P Worksheets 
To view the list of the of C&P worksheets that need their cosignature,  users can go to 

Tools menu then select My Unsigned C&P Worksheets. 

fig. 2-74 

Unsigned Templates 

Selecting My Unsigned C&P Worksheets from the Tools Menu displays a list of unsigned 

templates fig. 2-75. 

fig. 2-75 
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This window lists forms that have been started by examiners and not completed. Information 

provided includes ID (first letter of last name + last four digits of SSN), patient name, worksheet 

name(s), author, and status. 

Clicking the My Unsigned button displays the user’s own unsigned forms. 

Clicking the All Unsigned button displays all unsigned forms. 

Clicking the Review Pending button displays the forms that were sent for review. Only users 

who hold the DVBAB CPWM REVIEWER security key have access to documents waiting for 

review. All users can see the documents, but only reviewers can open and work with the 

documents. 

fig. 2-76 

The user selects the form to complete by double-clicking it. If it is clicked only once, the Display 

Form and Delete Form buttons are enabled. The user must hold the required security key to 

delete a template if it does not belong to him or her. The user clicks the Display Form button. 

Uncosigned C&P Worksheets 

To view the list of the of C&P worksheets that need their cosignature, users can go to the Tools 

menu then select My Uncosigned CPRS Documents. 

fig. 2-77 

If a document has been sent to the user for cosignature, the user is able to select the document 

from the list, view the report, add any addendum, and then cosign the document from CAPRI.  
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CPRS C&P Co signature transfer utility 

To view the list of cosigned and uncosigned documents that need to be transferred to AMIE, 

users go to the Tools menu and select CPRS C&P Cosignature Transfer Utility. 

fig. 2-78 

If a user cosigns a document in CPRS rather than in CAPRI, the document will appear on the 

cosignature transfer utility list. This utility can be used by clerical or other C&P staff to facilitate 

copying the CPRS document into AMIE and closing out the template in CAPRI.  If a user 

cosigns their C&P templates directly in CAPRI and not in CPRS, this utility will not need to be 

used. The dialog box in fig. 2-79 demonstrates items that need to be transferred or closed in 

CAPRI. 

fig. 2-79 

When users manually copy and paste a cosigned document from CPRS into AMIE, bypassing 

the CAPRI interface, CAPRI has no way of knowing this has taken place. The document will 

still need to be processed inside CAPRI. The Mark as Complete But Don’t Transfer button 

should be selected to complete the process in CAPRI; this option will complete the exam in 

CAPRI without transferring into AMIE fig. 2-80. 

fig. 2-80 
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Manage C&P Exam Request Report Management 

The Manage C&P Exam Requests option available on the Tools Menu can be used to reopen a 

released exam, release an open exam, change the status of an Exam Request, or edit the report of 

an exam that has already been signed and completed in CAPRI or AMIE. 

Reopen a Released Exam 

To reopen a released exam, the user clicks on the exam request date, selects the exam name 

under Exams, and clicks the Re-open this Request button. The user selects Yes to the warning 

message to reopen the exam 

fig. 2-81 

Change exam status 

Exam status can be changed to Open, Completed, Canceled by MAS, Canceled by RO, or 

Transferred out by using Option Manage C&P Exam Request functionality available on the 

Tools Menu. This opens the C&P Exam Request Report Management screen. 

The user clicks on the date then clicks on the desired exam. Then, the user clicks the Edit 

Selected Exam button to open the exam. 

fig. 2-82 

The user clicks on the down arrow button on the STATUS box to mark the new status for the 

selected exam. Exam Location, Date of the Exam and Examining Provider may also be edited. 

The user clicks the Save Changes button and then confirms changes by clicking the Yes button 

on the Confirm message box. 
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fig. 2-83 

Edit a released exam 

After a Released Exam is reopened (fig. 2-81), it may be selected by highlighting it in the Exams 

window. After highlighting the Exam the user clicks the Edit Selected Exam button (fig. 2-84) 

the Exam will appear in the Report Text window for editing 

fig. 2-84 
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Miscellaneous CPWM Functionalities 

fig. 2-85 

The Tools menu has some options that are not discussed elsewhere in the User Manual. 

View AMIE Worksheets 

Selecting AMIE Worksheets takes the user to a C&P website that provides an Index to 

Disability Examination Worksheets. Selecting a worksheet displays instructions for using the 

worksheets. 

Print Blank C&P Exam Templates 

This option allows the user to print a blank copy of a CPWM worksheet. 

Bring Exam Template to Front 

If a user is working on the C&P worksheets tab and loses template focus, or if the template 

happens to be stuck in the background, users can go to the Tools menu and select Bring Exam 

Template to the front. This brings the template back into focus. 
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Additional CAPRI Functionality 

CAPRI Remote Functionality 

CAPRI REMOTE: CAPRI-Remote users will access CAPRI through the Claims 

system, which runs on the VHA Forum hardware. The server for those users should be 

set to ―forum.va.gov,‖ port ―9400‖. CAPRI-Remote users outside of VBA will normally 

obtain an access code from the Office of Information (OI) Support staff, not from the 

local field site. Most VBA users are CAPRI-Remote users. Most VHA users are local site 

users. 

If a user starts CAPRI and does not successfully connect to a VistA system within 90 

seconds, CAPRI will automatically shut down. 

When users are logging into CAPRI remotely, CAPRI will alert users when no e-mail 

account is set up. 

Switch sites – on the File Menu 

The Switch Sites option (available on the File Menu) is active if the user is accessing a VistA 

system with ―remote‖ capability. If the selection is active, the user may have other VistA 

accounts they can connect to without re-authenticating 

fig. 2-86 

Capri Remote users can use this option to switch from one site to another without logging out of 

CAPRI. This option is only available when users are logged into the claims server with remote 

access. Users can access the switch site option from the file menu. After switch sites is selected, 

the user is prompted with the site list to allow them to choose site to which they would like to 

switch. 

Check Remote Connections 

Check Remote Connections (found on the Help menu) is available to users with @ or U level 

FileMan access. This will provide a utility to scan CAPRI remote sites to discover any 

connectivity issues. 

To use this function, the user selects the connections to scan in the left list box, or clicks Select 

All. Then click Run Selected. Any connection problems are listed under ―Could not connect to:‖ 

This does not mean that the site is down nation-wide; it means that the current user cannot access 

the site, which could be due to a number of reasons. 
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fig. 2-87 

Edit Remote User Site Access 

Edit Remote User Site Access (found on the Help Menu) is available to users with @ or U level 

FileMan access. This tool allows a CAPRI administrator to change the remote sites for specific 

CAPRI users, either limiting their site list or providing the full list of VHA VistA systems to the 

user. This list is presented to the user when CAPRI is started in remote mode. 

fig. 2-88 

To use this utility, the user selects a name from the left column. The user list is generated from 

the Claims system, which runs on the Forum hardware hosted by the VHA Office of Information 

in Silver Spring, MD.  The second column is updated with the user’s site access privileges. 

Show all sites will default the user’s site list to every available VistA site. If the user should only 

have access to a limited number of sites, select No for this radio group and update the user’s 

allowed sites under Authorized Sites. 

One user’s site list can be copied to other users. This is useful when a known group of users 

access the same sites. This function is accomplished using the third column of the utility. First, 

select one of the users and update their sites using the second column. After the user is set up 

correctly, click the Use Selected as Parent Clone button. This user will then be listed next to the 

Parent Clone label. Next, select each user who should have the same site list and click the Add 
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Selected to Child Clone List button. After the list is set up correctly, the user completes the 

process by clicking the Start Cloning button. 

Consolidated Remote Reports 

Consolidated Remote Reports (found on the Help menu) is available to users of CAPRI when 

in remote mode. This report tool was primarily created for the Tiger Team to run reports on 

multiple VistA accounts at the same time.  To use it, the user clicks the sites on which the report 

is to run in the Available Connections list box. The user then enters stop and start dates and 

chooses a report type. Then, Run Selected is clicked. This dialog box has its own Print button 

which should be used instead of selecting Print from the File menu and printing from the main 

CAPRI interface. 

fig. 2-89 

Audit Trail Download utility 

Audit Trail Download Utility (found on the Help menu) is available to users with @ or U level 

FileMan access and who have been provided an additional secondary menu option on the Claims 

system. This tool is used by VBA to download CAPRI audit data for internal reporting. Although 

a user may see this option on their menu, they may not have the secondary menu option that 

allows it to run.  The utility will automatically continue at the last point it stopped if the same 

filename is selected as during a previous session. If a new filename is created, the utility will 

start from scratch and download every entry in the VistA Claims system database. 

fig. 2-90 
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Miscellaneous CAPRI Functionality 

Edit Exam List Parameters 

Menu option Edit Exam List Parameter (MAS) is under Tools on the CAPRI menu bar as shown 

below. Exam List Parameter (MAS) is a tool used by sites to define which exams are performed 

at a division. When an exam request is made via the C&P exams tab, the exam list displays 

exams as performed or not performed in a division according to this definition. 

fig. 2-91 

The security key ―Edit Exam List Parameter (MAS)‖ should be assigned to the MAS 
ADPAC, C&P Clinic Clerk, or other individual who is responsible for maintaining the list of 

C&P exams performed at the site. 

The user who has the security key above (or programmer access should see Edit Exam List 

Parameter (MAS) under the Tools menu option after logging into the CAPRI GUI executable. 

If the user does not have option context "DVBA CAPRI GUI," assign it to their secondary 

menu. 

For users who do not hold this key or have ―@‖ FileMan access, the option is invisible. 

When user clicks on the Edit Exam List Parameter (MAS) option, the dialog box below is 

displayed. Parameters that are set in this window are displayed in the Add a New C&P Exam 

dialog box. 
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fig. 2-92 

The first time the user uses the option, it will set up the entire division list and make them all 

active. 

To turn off a division so it does not show for user selection – select the division on the left of 

the screen then click the box labeled, ―Completely Inactivate this Division‖ in the Edit Exam 
List Parameters (MAS) window as shown in the screen capture above. 

A textbox is provided for comments relating to specific division.
 
When selecting Edit Exam List Parameters (MAS) for the first time, CAPRI will 

automatically find the site's divisions and activate all exams for each division in a default list. 

The user will then be able to add new lists or modify the default list that was created. 

To enable a specified group of users to order certain exams, the user may create a custom list 

by clicking the Add New button in the Edit Exam List Parameters (MAS) window. 

When the user selects an exam list defined for a division, the Edit Selected button is enabled. 

Clicking on this button will trigger the display of the screen below to enable users to modify the 

list of exams and add comments about a particular list and/or exam. 

fig. 2-93 
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The checkmarks in the checkboxes next to the exam name indicates that the exams are 

activated. 

Users can modify (turn off) the default as well as the custom exam list by clearing the check 

mark from the checkboxes next to the exams they wish to turn off. This will cause the exam 

to display in red in the Add a New Exam dialog box, indicating that the exam is not 

performed at the particular facility. 

If exams are turned off via future DVB patches, they will no longer show in the New Exam 

dialog box. 

If a patch releases a new exam, it is shown to all users until someone uses Edit Exam List 

Parameter (MAS) to turn it off. 

Comments may be added for the exam list in the section labeled Comment for this list of 

exams. 

Users can place comments, reminders, notes, etc. about an exam in the text box labeled, 

Comment to be displayed when this exam is selected. Clicking on the exam will bring the 

textbox to view. 

DOD Records Tab 

Department of Defense (DoD) records will now be available for certain veterans beginning 

approximately six weeks after discharge. These records are available through the Federal Health 

Information Exchange. The user will know if DoD records are available when accessing the 

Patient Selector screen. In fig. 2-94, the notation ―DOD data is available‖ indicates that the user 

can access these records after selecting the patient. The patient demographic data is not visible in 

this specific example because it is a sensitive level record. 

fig. 2-94 

After the user selects this patient, a new tab is available; the DoD Records tab (fig. 2-95). This 

tab will not be visible, or is grayed out, for patients who do not have FHIE records available. 

Step 1 - Click the DoD Records tab. The following screen opens (fig. 2-95): 
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fig. 2-95 

Step 2 - The available reports are listed in the left window. Fig. 2-95 shows primarily laboratory 

and test results, together with discharge summaries and outpatient prescriptions. The FHIE 

framework requires a Start Date and a Stop Date before any data is returned.  FHIE records, if 

available, could date back to 1989.  After entering a Start Date and a Stop Date in the lower left 

corner, select the type of report the user want to view. 

Step 3 - If more than one report of the selected type is available, they are listed in the top 

window. Fig. 2-95 shows two discharge summaries. Select the summary or report that the user 

would like to view, and that report will appear in the lower window. 

Step 4 - The selected summary or report will appear in the lower window. 

*Note: The user can specify particular dates to search for reports using the Start Date and Stop 

Date fields in the lower left corner. 

*Note: The C&P Worksheets tab in the screen above no longer exists (fig. 2-95). This 

functionality was moved. It is now located under CAPRI - Reports (File/Reports) as C&P Exams 

Checklist. 

Vista Web Tab 

VistaWeb is an intranet web application used to review remote patient information found in the 

Veterans Information Systems Technology Architecture (VistA) and the Health Data Repository 

(HDR) databases. VistaWeb mirrors the behavior of the Computerized Patient Record System 

(CPRS) and Remote Data View (RDV). Compensation and Pension Record Interchange 

(CAPRI) users can view the data on VistaWeb, but cannot make changes to VistaWeb pages. 

This is a simulation of a VistaWeb page. 
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fig. 2-96 

Set Up Options 

Printer Set Up 

CAPRI has Windows printer functionality. The user can generate printouts using your default 

printer selection. 

Step 1 - Click on File/Print Set up (fig. 2-97). 

fig. 2-97 

Step 2 - CAPRI displays your current default printer (fig. 2-98). If the user has more than one 

printer, he or she can click the down arrow at the end of the printer name to see a list of available 

printers. The user can then select a printer from that list. To permanently change your default 

printer, contact IRM or use the printer’s applet under the Windows control panel. 
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fig. 2-98 

Display Properties 

The properties can be accessed from the Tools Menu. 

fig. 2-99 

Properties 

This option allows the user to change the way the PC looks and works (fig. 2-100). 
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fig. 2-100 

Display Settings (fig. 2-100) takes the user to the standard Windows Display Settings dialog box 

that can be opened using Start/Settings/Control Panel/Display (fig. 2-101). 

fig. 2-101 

Accessibility (fig. 2-100) takes the user to the standard Windows Accessibility Options dialog 

box that the user can open using Start/Settings/Control Panel/Accessibility Options (fig. 2-102). 

fig. 2-102 

Change Font (fig. 2-100) takes the user to the standard Windows Fonts dialog box that can be 

opened using Start/Settings/Control Panel/Fonts (fig. 2-103). 
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fig. 2-103 

Patient Lookup Keyboard Sensitivity (fig. 2-100) adjusts the amount of time CAPRI waits after a 

keystroke before searching for the patient on the Patient Selector screen. The user should not 

change this from the default setting of 500 milliseconds unless there are difficulties. 

If the user make any changes to these settings and want to undo the changes, click the Restore 

Original Font/Keyboard Settings button (fig. 2-100). 

Change Forwarding Address 

Change Forwarding Address on the Tools Menu allows the user to specify an Exchange email 

address for forwarding MailMan messages and CAPRI reports (fig. 2-99). The user can find an 

Exchange email address by opening the Address Book in your email application, and searching 

for the desired name. After the user find the name, right-click with your mouse, select Properties, 

and then go to the E-mail Addresses tab. Contact your local Information Resources Management 

(IRM) staff if the user have difficulty identifying your email addresses. 

Forwarding e-mail address 

NOTE: This e-mail address is used for automated AMIE responses to certain activity – cancelled 

C&P exam requests and completed C&P exam request bulletins is e-mailed back to the user if 

there is an e-mail address specified. (See fig. 2-104) 
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fig. 2-104 

Help Menu 

For most users, this menu will only have two items, About (fig. 2-105) and CAPRI C&P 

Template Training Website. Other items only show up for Veterans Benefits Administration 

(VBA) users or users who have been assigned these options 

fig. 2-105 

About 

The About screen displays the CAPRI version number. The user can also see version number on 

the CAPRI splash screen, visible at start-up or whenever switching sites when using CAPRI in 

remote mode. 
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fig. 2-106 

Click the OK button (fig. 2-106) to close the About screen. The user should have this information 

if the user need to report a problem. 

Training website 

CAPRI C&P Template Training Website takes user to the CAPRI website with video training 

materials. 

VistA Terminal 

A user launches a VistA Terminal session by clicking the VistA button to log into the local 

VistA system. When the VistA button is clicked, a mini telnet window opens that allows the user 

to be automatically logged into their local VistA system, where he or she has access to regular 

VistA functionality. 
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Troubleshooting and Error Messages 

Note: in all cases, please print the error message for your local Information Resources 

Management (IRM) staff. 

CAPRI not installed in VistA 

fig. 3-1 

The user receives the message in fig. 3-1 if the Veterans Health Administration (VHA) 

Medical Center has not loaded the VHA half of the CAPRI software. Contact your local 

IRM staff if the user get this message. 

CAPRI GUI Option not assigned to user in VistA 

fig. 3-2 

The user receives the message in fig. 3-2 if the VHA medical center has not assigned the 

CAPRI option to RO users. The user will have to contact local IRM staff upon receiving 

the above message. 

VistA server down 

fig. 3-3 

The user receives the message in fig. 3-3 or a similar one, such as WSAETIMEDOUT, 

when there are performance issues in the VA Wide Area Network (WAN), if a server is 

down, or if a server was not restarted after being down. When this happens, the 

Automated Medical Information Exchange (AMIE) II may or may not connect, 

depending on the exact problem. Please test the AMIE II connection. 
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VistA limits ability to see patient records 

fig. 3-4 

The user receives the message in fig. 3-4 if the medical facility made local permission 

modifications in VistA that prohibit users from seeing the contents of patient records. 

Network problems 

fig. 3-5 

The user receives the message in fig. 3-5 if the connection to the medical facility is lost 

unexpectedly. Try to connect to the medical facility again. 

Institution file in VistA has been locally modified 

fig. 3-6 
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The user may receive the message in fig. 3-6 when requesting exams, requesting 7131s, 

or entering new patients if the VHA medical facility has an incomplete or incorrect 

Regional Office list in their system. 

Too many invalid attempts at access code / verify code 

fig. 3-7 

The user receives the message in fig. 3-7 if the user attempted to log on and entered the 

wrong Access Code / Verify Code combination too many times (3 times). 

Multiple sign-ons 

fig. 3-8 

The user may receive the message in fig. 3-8 if the user did not log out of CAPRI 

correctly or if your session was unexpectedly disconnected. 

General error message 

fig. 3-9 

The user may receive the message in fig. 3-9 for a number of possible reasons. If the user 

get this message, cancel your current task, close CAPRI, and then sign on again. If the 

user receive this error message again, contact your local IRM staff for assistance. 
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CAPRI Equivalents for AMIE II Functions
 

AMIE Function CAPRI Function 

*Admission Inquiry by Date (All 

Admissions) 

No CAPRI equivalent yet 

*Print New Notices of Discharge No CAPRI equivalent yet 

Add an Exam to an Existing Request C&P Exams - View/Edit Selected Request 

- Add Exam to Request 

Ad Hoc Health Summary Health Summaries - Adhoc Report 

Admission Report for Service Connected 

Veterans 

CAPRI Reports - Admission Report for SC 

Veterans 

AMIS 290 for the Regional Office CAPRI Reports - AMIS 290 

Beneficiary Information Status Inquiry 7131 Request - Status Inquiry 

Cancel C&P Requests (all exams) C&P Exams - View/Edit Selected Request 

- Cancel ALL Exams 

Cancel C&P Requests (selected exams) C&P Exams - View/Edit Selected Request 

- Select Exam - View Exam - Cancel This 

Exam 

Detailed Inpatient Inquiry Reports - Detailed Inpt. Inquiry 

Discharge Report (A&A, Pension, Service 

Connected, All) 

CAPRI Reports - Discharge Report (A&A, 

Pension, SC, All) 

Edit 7131 Remarks 7131 Request - View/Edit Selected Request 

Edit C&P Request Information C&P Exams - View/Edit Selected Request 

Edit Patient Address Information Admin - Edit Address Information 

Enter a C&P Exam Request C&P Exams - Add a New Request 

Full Patient Profile MAS Reports - Patient Profile MAS (Full) 

HS Health Summary Menu Health Summaries tab 

Incompetent Veterans Report CAPRI Reports - Incompetent Veterans 

Report 

INPT Detailed Inpatient Inquiry Reports - Detailed Inpt. Inquiry 

INQ Patient Inquiry Reports - Pt. Inquiry 

Inquiry for C&P Requests C&P Exams - Status Inquiry 

Insufficient Exam Report CAPRI Reports - Insufficient Exam Report 

LAB Interim Report Clinical Documents - Lab tab 
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AMIE Function CAPRI Function 

NHE Network Health Exchange Options CAPRI Remote Data View 

NOTE Print Document Menu Clinical Documents - Notes tab 

OP Operation Report Reports - Surgery Report 

PDX Patient Data Exchange CAPRI Remote Data View 

Pending C&P Exams Report CAPRI Reports - Pending C&P Exams 

Pending Form 7131 Requests Report CAPRI Reports - Pending Form 7131 

Requests 

Print C&P Final Report (Manual) Print C&P Final Report (Manual) 

Print Exam Check List for RO CAPRI Reports - C&P Exams Checklist 

Re-admission Report CAPRI Reports - Re-Admission Report 

Regional Office 21-day Certificate Printing CAPRI Reports - 21 Day Certificate 

Printing 

Regional Office Patient Inquiry Reports - Pt. Inquiry 

REG View Registration Data Reports - View Registration Data 

Report for Pension and A&A CAPRI Reports - Discharge Report, select 

Pension or A&A 

Reprint a 21-day Certificate for the RO CAPRI Reports - Reprint a 21 Day 

Certificate (can run with or without a 

patient selected) 

Reprint a Notice of Discharge CAPRI Reports - Reprint a Notice of 

Discharge (can run with or without a 

patient selected) 

Reprint C&P Final Report Re-Print C&P Final Report(s) 

Request for 7131 Information 7131 Request - Add a New Request 

XRAY Radiology Reports for VARO Clinical Documents - Imaging tab 
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CAPRI Locations for Medical Evidence 
*Note: this list is not meant to be all-inclusive in terms of providing the evidentiary requirements 

for the evaluation of disabilities. Rather it is meant to provide helpful hints for locating 

commonly used types of medical evidence. 

What do I need? Where to go in CAPRI: 

MUSCULOSKELETAL (DC 5000, 5100, 5200, 5300) 

History and Physical Examinations C&P Exam, Notes, Discharge Summaries 

Magnetic Resonance Imaging (MRI) Imaging Tab 

X-rays Imaging Tab 

Arthrograms (X-ray dye) Imaging Tab 

Arthroscopies Imaging Tab 

Range of Motion Studies Notes Tab, Consults Tab 

Surgical Procedures Reports Tab/Surgery Report 

Surgical Pathology Labs Tab/Anatomic Pathology 

Prescribed medications Meds Tab 

EYE (DC 6000) 

History and Physical Examinations C&P Exam, Notes, Discharge Summaries 

Ophthalmology reports Notes Tab, Consults Tab 

Eye exams w/Snellen test (visual acuity) and 

Goldmann Perimeter Chart (field test) 

Notes Tab, Consults Tab 

Surgical Procedures Reports Tab/Surgery Report 

Surgical Pathology Labs Tab/Anatomic Pathology 

Prescribed medications Meds Tab 

EAR AND OTHER SENSE ORGANS (DC 6100, 6200) 

History and Physical Examinations C&P Exam, Notes, Discharge Summaries 

Audiologic (conductive/sensorineural) tests Notes Tab, Consults Tab 

Audiograms (puretone threshold/speech 

recognition scores) 

Notes Tab, Consults Tab 

Electrogustometry (taste sensation) Notes Tab, Consults, Procedures Tab 

Prescribed medications Meds Tab 
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What do I need? Where to go in CAPRI: 

INFECTIOUS DISEASES, IMMUNE DISORDERS AND NUTRITIONAL 

DEFICIENCIES (DC 6300) 

History and Physical Examinations C&P Exam, Notes, Discharge Summaries 

Blood tests (creatinine, BUN, albumin) Labs Tab/Cumulative/Graph 

Skin tests Labs Tab/Anatomic Pathology, Notes, Consults 

Stool cultures Labs Tab/Microbiology/Cumulative 

T4 Cell Count Labs Tab/Cumulative/Graphs 

Serology Labs Tab/Cumulative/Graphs 

Weight Loss Vitals Tab/Graph 

Prescribed medications Meds Tab 

RESPIRATORY SYSTEM (DC 6500, 6600, 6700, 6800) 

History and Physical Examinations C&P Exam, Notes, Discharge Summaries 

Pulmonary Function Tests (PFT) Procedures Tab, Notes Tab (interpretation) 

X-rays Imaging Tab 

Sleep Studies Notes Tab, Consults Tab 

Surgical Procedures Reports Tab/Surgery Report 

Surgical Pathology Labs Tab/Anatomic Pathology 

Prescribed medications Meds Tab 

CARDIOVASCULAR SYSTEM (DC 7000, 7100) 

History and Physical Examinations C&P Exam, Notes, Discharge Summaries 

X-rays Imaging Tab 

Electrocardiograms (ECG/EKG) Procedures, Consults, Notes (interpretation) 

Exercise Stress tests (METS) Procedures, Consults, Notes (interpretation) 

Echocardiography/Ejection Fraction tests Procedures, Consults, Notes (interpretation) 

Holter monitor Procedures, Consults, Notes (interpretation) 

Doppler studies (ankle/brachial index) Imaging Tab 

Blood Pressure Vitals Tab/Graph 

Surgical Procedures Reports Tab/Surgery Report 

Surgical Pathology Labs Tab/Anatomic Pathology 

Prescribed medications Meds Tab 
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What do I need? Where to go in CAPRI: 

DIGESTIVE (DC 7200, 7300) 

History and Physical Examinations C&P Exam, Notes, Discharge Summaries 

X-rays Imaging Tab 

Barium enema (colon X-ray) Imaging Tab 

Sigmoidoscopies Notes Tab, Consults Tab 

Endoscopies Notes Tab, Consults Tab 

Proctoscopies Notes Tab, Consults Tab 

Colonoscopies Notes Tab, Consults Tab 

Liver biopsies Labs Tab/Anatomic Pathology 

Gastrointestinal - upper and lower - series Imaging Tab 

Liver Function Tests (LFT) Labs Tab/Cumulative/Graph 

Weight Loss Vitals Tab/Graph 

Dietary Restrictions Nutritional Assessment Tab, Diet Tab 

Surgical Procedures Reports Tab/Surgery Report 

Surgical Pathology Labs Tab/Anatomic Pathology 

Prescribed medications Meds Tab 

GENITOURINARY SYSTEM (DC 7500) 

History and Physical Examinations C&P Exam, Notes, Discharge Summaries 

Urinalysis (macro and micro) Labs Tab/Cumulative/Microbiology/Graphs 

Blood tests (creatinine, BUN, albumin) Labs Tab/Cumulative/Graph 

Complete Blood Count test (CBC) Labs Tab/Cumulative/Graph 

Uroflowmetry Consults Tab, Notes Tab 

Semen and endocrine evaluations Labs Tab/Cumulative/Graph 

Surgical Procedures Reports Tab/Surgery Report 

Surgical Pathology Labs Tab/Anatomic Pathology 

Prescribed medications Meds Tab 
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What do I need? Where to go in CAPRI: 

GYNECOLOGICAL CONDITIONS AND DISORDERS OF THE BREAST (DC 7600) 

History and Physical Examinations C&P Exam, Notes, Discharge Summaries 

Laparoscopies Notes Tab, Consults Tab 

X-rays Imaging Tab 

Ultrasounds Imaging Tab 

Pap smears Labs Tab/Cumulative/Microbiology 

Urinalysis (macro and micro) Labs Tab/Cumulative/Microbiology/Graphs 

Complete Blood Count test (CBC) Labs Tab/Cumulative/Graph 

Ultrasounds Imaging Tab 

Mammographies Imaging Tab 

Surgical Procedures Reports Tab/Surgery Report 

Surgical Pathology Labs Tab/Anatomic Pathology 

Prescribed medications Meds Tab 

HEMIC AND LYMPHATIC SYSTEMS (DC 7700) 

History and Physical Examinations C&P Exam, Notes, Discharge Summaries 

Hemoglobin - See CBC Labs Tab/Cumulative/Graph 

X-rays Imaging Tab 

Platelet count (Thrombocyte) - See CBC Labs Tab/Cumulative/Graph 

Magnetic Resonance Imaging (MRI) Imaging Tab 

CT scans Imaging Tab 

Prescribed medications Meds Tab 

SKIN (DC 7800) 

History and Physical Examinations C&P Exam, Notes, Discharge Summaries 

Skin biopsies Labs Tab/Anatomic Pathology 

Surgical Procedures Reports Tab/Surgery Report 

Surgical Pathology Labs Tab/Anatomic Pathology 

Prescribed medications Meds Tab 
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What do I need? Where to go in CAPRI: 

ENDOCRINE SYSTEM (DC 7900) 

History and Physical Examinations C&P Exam, Notes, Discharge Summaries 

T4 (Thyroxine test) Labs Tab/Cumulative/Graph 

T3 (Triiodothyronine or T3 

Radioimmunoassay test) 

Labs Tab/Cumulative/Graph 

TSH (Thyrotropin or Thyroid Stimulating 

Hormone test) 

Labs Tab/Cumulative/Graph 

Renal function tests Labs Tab/Cumulative/Graph 

Blood sugar Labs Tab/Cumulative/Graph 

Urinalysis (macro and micro) Labs Tab/Cumulative/Graph/Microbiology 

Dietary Restrictions Nutritional Assessment, Diet Tab (inpatient) 

Glucose Tolerance test Labs Tab/Cumulative/Graph 

Surgical Procedures Reports Tab/Surgery Report 

Surgical Pathology Labs Tab/Anatomic Pathology 

Prescribed medications Meds Tab 

NEUROLOGICAL CONDITIONS AND CONVULSIVE DISORDERS (DC 8000-8900) 

History and Physical Examinations C&P Exam, Notes, Discharge Summaries 

Electromyographies, Myograms (EMG) Procedures, Consults, Notes (interpretation) 

Nerve Conduction Velocity (NCV) Procedures, Consults, Notes (interpretation) 

Electroencephalograms, Brain wave tests Procedures, Consults, Notes (interpretation) 

Magnetic Resonance Imaging (MRI) Imaging Tab 

X-rays Imaging Tab 

Prescribed medications Meds Tab 
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What do I need? Where to go in CAPRI: 

MENTAL DISORDERS (DC 9200-9500) 

History and Psychiatric Examinations C&P Exam Tab, Notes Tab, Discharge 

Summaries Tab 

Social and Industrial Surveys Notes Tab, Consults Tab 

Global Assessment of Functioning (GAF) Notes Tab, Consults Tab 

Dietary Restrictions Nutritional Assessment Tab, Diet Tab 

(inpatient) 

Weight Loss Vitals Tab/Graph 

Prescribed medications Meds Tab 

DENTAL AND ORAL CONDITIONS (DC 9900) 

History and Dental Examinations C&P Exam Tab, Notes Tab, Discharge 

Summaries Tab 

X-rays Imaging Tab 

Glossary
 
CAC Clinical Applications Coordinator. The CAC is a person at a hospital or clinic 

assigned to coordinate the installation, maintenance and upgrading of CPRS 

and other VistA software programs for the end users. 

CAPRI Compensation and Pension Record Interchange 

Consults Consult/Request Tracking, a VistA product that is also part of CPRS (it can 

function as part of CPRS, independently as a standalone package, or as part of 

TIU). It is used to request and track consultations or procedures from one 

clinician to another clinician or service. 

C&P Compensation and Pension 

CPEP Compensation and Pension Examination Program 

CPRS Computerized Patient Record System, the VistA package (in both GUI and 

character-based formats) that provides access to most components of the 

patient chart 

CPWM Compensation and Pension Worksheet Module 

Discharge Summary A component of TIU that can function as part of CPRS, Discharge Summaries are 

recapitulations of a patient’s course of care while in the hospital. 
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GUI Graphical User Interface—a Windows-like screen with pull-down menus, icons, 

pointer device, etc. 

Health Summary A VistA product that can be viewed through CPRS, Health Summaries are 

components of patient information extracted from other VistA applications 

Imaging A VistA product that is also a component of CPRS; it includes Radiology, X-rays, 

Nuclear Medicine, etc. 

NP Nurse Practitioner 

Nurse Practitioner A registered nurse who has received special training and can perform many of the 

duties of a physician 

Progress Notes A component of TIU that can function as part of CPRS 

TIU Text Integration Utilities; a package for document handling, that includes 

Consults, Discharge Summary, and Progress Notes, and will later add other 

document types such as surgical pathology reports. TIU components can be 

accessed for individual patients through the CPRS, or for multiple patients 

through the TIU interface. 

VBA Veterans Health Administration 

VHA Veterans Benefits Administration 

VistA Veterans Information Systems Technology Architecture, the new name for 

Decentralized Hospital Computer Program (DHCP) 

VistaWeb An intranet web application used to review remote patient information found in 

VistA and the Health Data Repository (HDR) databases 
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